
ibm.com/redbooks

Migrating from 
Netfinity Manager
to Netfinity Director

David Watts
Johan Fransson

Sonny Grover
Sutikno Lukito

Helps you plan for and implement a 
conversion

Explains how the two products 
can coexist

Shows what data can be 
transferred 

http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/




Migrating from Netfinity Manager
to Netfinity Director

July 2000

SG24-6155-00

International Technical Support Organization



© Copyright International Business Machines Corporation 2000. All rights reserved.
Note to U.S Government Users – Documentation related to restricted rights – Use, duplication or disclosure is
subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.

First Edition (July 2000)

This edition applies to Netfinity Director Version 2.12.

Comments may be addressed to:
IBM Corporation, International Technical Support Organization
Dept. HZ8 Building 678
P.O. Box 12195
Research Triangle Park, NC 27709-2195

When you send information to IBM, you grant IBM a non-exclusive right to use or distribute the
information in any way it believes appropriate without incurring any obligation to you.

Before using this information and the product it supports, be sure to read the general information in
Appendix B, “Special notices” on page 185.

Take Note!



© Copyright IBM Corp. 2000 iii

Contents

Preface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
The team that wrote this redbook. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Comments welcome. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ix

Chapter 1. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Chapter 2. Comparing Netfinity Director with Netfinity Manager . . . . . 3
2.1 Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

2.1.1 Netfinity Director server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
2.1.2 Netfinity Director console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.1.3 Netfinity Director agent . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.1.4 UM Server Extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2.2 Differences between the products . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
2.2.1 Architecture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
2.2.2 Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.2.3 Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
2.2.4 Wake On LAN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

2.3 Netfinity Director functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
2.3.1 Advanced System Management . . . . . . . . . . . . . . . . . . . . . . . . . 18
2.3.2 Asset ID . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
2.3.3 Capacity Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
2.3.4 CIM Browser. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
2.3.5 Configure Alert on LAN. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
2.3.6 Configure SNMP Agent . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
2.3.7 DMI Browser. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
2.3.8 Event Action Plans . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
2.3.9 Event Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
2.3.10 File Transfer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
2.3.11 IBM Cluster Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
2.3.12 Inventory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
2.3.13 Microsoft Cluster Browser. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
2.3.14 Process Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
2.3.15 Remote Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
2.3.16 Resource Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
2.3.17 Scheduler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
2.3.18 ServeRAID Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
2.3.19 Software Distribution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

2.4 What is missing in Netfinity Director . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Chapter 3. Planning to migrate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
3.1 Deployment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31



iv Migrating from Netfinity Manager to Netfinity Director

3.1.1 Coexistence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
3.1.2 Migration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

3.2 Implementation road map . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
3.2.1 Planning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
3.2.2 Design . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
3.2.3 Implementation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
3.2.4 Training . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

3.3 Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
3.4 Supported systems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

3.4.1 Operating system summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
3.4.2 Netfinity Director server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
3.4.3 Netfinity Director console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
3.4.4 Netfinity Director client (UM Services) . . . . . . . . . . . . . . . . . . . . 39

3.5 Licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
3.5.1 MPM licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
3.5.2 IT Director licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Chapter 4. Installing Netfinity Director server and console. . . . . . . . . 45
4.1 Before you begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
4.2 Installing the server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
4.3 Installing the console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Chapter 5. Coexistence using MPM . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
5.1 What you can do with MPM? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
5.2 Before you begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
5.3 Scenario 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

5.3.1 Install UMS on one of the Netfinity Manager systems . . . . . . . . . 62
5.3.2 Install Netfinity Director server . . . . . . . . . . . . . . . . . . . . . . . . . . 64
5.3.3 Configure MPM. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

5.4 Scenario 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
5.4.1 Install Netfinity Director server . . . . . . . . . . . . . . . . . . . . . . . . . . 71
5.4.2 Configure MPM. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

5.5 Managing MPM systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
5.5.1 Sending alerts to Netfinity Director . . . . . . . . . . . . . . . . . . . . . . . 79
5.5.2 Collecting inventory from Netfinity Manager clients. . . . . . . . . . . 89
5.5.3 Software distribution to Netfinity Manager systems. . . . . . . . . . . 92

Chapter 6. Installing UMS on clients . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
6.1 Installing UMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

6.1.1 Manually installing the Windows client . . . . . . . . . . . . . . . . . . . . 93
6.1.2 Manually installing OS/2 clients . . . . . . . . . . . . . . . . . . . . . . . . 100
6.1.3 Manually installing NetWare clients . . . . . . . . . . . . . . . . . . . . . 104

6.2 Unattended installation of UMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
6.2.1 Unattended installations on Windows . . . . . . . . . . . . . . . . . . . . 105



v

6.2.2 Unattended installations on OS/2 . . . . . . . . . . . . . . . . . . . . . . . 109
6.2.3 Getting the code to the clients . . . . . . . . . . . . . . . . . . . . . . . . . 110

6.3 Software distribution through MPM . . . . . . . . . . . . . . . . . . . . . . . . . . 112
6.4 Installing UM Server Extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

6.4.1 Unattended installation of UM Server Extensions . . . . . . . . . . . 118

Chapter 7. Recreating configuration data . . . . . . . . . . . . . . . . . . . . . . 121
7.1 Alert Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
7.2 Security Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
7.3 System Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

7.3.1 Exporting recorded data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141
7.4 Event Scheduler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
7.5 Remote System Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147

7.5.1 Edit TWGUSER.INI. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
7.5.2 Asset ID . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

7.6 Process Management. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
7.7 Advanced System Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160

Chapter 8. Removing Netfinity Manager . . . . . . . . . . . . . . . . . . . . . . . 161
8.1 Uninstalling Netfinity Manager 5.x . . . . . . . . . . . . . . . . . . . . . . . . . . 161

8.1.1 Manual uninstall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
8.1.2 Unattended uninstall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162

8.2 Uninstalling versions earlier than Netfinity Manager 5.x . . . . . . . . . . 162

Chapter 9. Upgrading to IT Director . . . . . . . . . . . . . . . . . . . . . . . . . . 165
9.1 Extra features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165

9.1.1 Software distribution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
9.1.2 SNMP functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169
9.1.3 Application management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
9.1.4 Internet services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
9.1.5 Advanced group management . . . . . . . . . . . . . . . . . . . . . . . . . 173
9.1.6 Associations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
9.1.7 AS/400 Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176

9.2 How to upgrade Netfinity Director to IT Director . . . . . . . . . . . . . . . . 176

Appendix A. Worksheets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179
A.1 Alert Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179
A.2 Security Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
A.3 System Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
A.4 Scheduler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
A.5 Process Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183



vi Migrating from Netfinity Manager to Netfinity Director

Appendix B. Special notices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185

Appendix C. Related publications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
C.1 IBM Redbooks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
C.2 IBM Redbooks collections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
C.3 Other resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
C.4 Referenced Web sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190

How to get IBM Redbooks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193
IBM Redbooks fax order form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194

Abbreviations and acronyms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

IBM Redbooks review . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203



© Copyright IBM Corp. 2000 vii

Preface

In 1993, IBM announced Version 1.1 of NetFinity Manager and NetFinity
Services. The products supported OS/2 2.0 with planned support for
Windows 3.1 manager systems and Windows 3.1, NetWare 3.11 and
NetWare 4.0 client systems. NetFinity Manager shipped on one 3.5" diskette
and Services shipped on two 3.5" diskettes. The product went through three
name changes since then: to IBM PC SystemView in early 1996, to TME 10
NetFinity in late 1996, then to IBM Netfinity Manager (lower-case F) in 1997.

In 1999, IBM announced a new product, Netfinity Director, which was based
on Tivoli IT Director and was to replace Netfinity Manager. The current
version, V2.12 announced in April 2000, builds on the function and features
of the new product.

This redbook describes the migration process that will help customers with
the transition from Netfinity Manager to Netfinity Director. We explain the
differences between the products and what you need to consider before you
begin. The book then explains how to configure your management
environment so that Netfinity Manager and Netfinity Director can coexist, and
what options you have to roll out UM Services, the Netfinity Director agent, to
all of your client workstations and servers. Finally we help you retrieve your
data from your Netfinity Manager configurations and put that into Netfinity
Director. We also discuss the Tivoli IT Director product and how it compares
to Netfinity Director.

This book is aimed at customers, business partners and IBMers who will be
involved in migrating existing Netfinity Manager installations to Netfinity
Director. A partner redbook to this publication is Netfinity Director Integration
and Tools, SG24-5389. The combination of these two books will help you
understand what Netfinity Director is compared to Netfinity Manager, how to
use Netfinity Director, and how to migrate from one to the other.

The team that wrote this redbook

This redbook was produced by a team of specialists from around the world
working at the International Technical Support Organization, Raleigh Center.

David Watts is an Advisory Specialist for Netfinity Servers at the ITSO
Center in Raleigh. He manages residencies and produces redbooks on
hardware and software topics related to IBM Netfinity servers. He has
authored over a dozen publications; his most recent books include Netfinity
and Windows 2000 Integration Guide and Tuning Netfinity Servers for
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Performance. He has a Bachelor of Engineering degree from the University of
Queensland (Australia) and has worked for IBM for over 11 years. He is an
IBM Professional Server Specialist and is an IBM Certified IT Specialist.

Johan Fransson is an Advisory IT Specialist in Stockholm, Sweden. He has
five years of experience in the systems management field. He has worked for
IBM for one and a half years as a Tivoli consultant. He is certified as a Tivoli
Certified Solutions Expert for Tivoli IT Director, Tivoli Certified Consultant in
Enterprise Tivoli, MCSE, OS/2 Engineer, and OS/2 LAN Server Engineer. His
areas of expertise include infrastructure, planning and migrations. Prior to
working for IBM he worked for the business partner System Integration i
Växjö AB, a franchise of the company Office in Sweden.

Sonny Grover is the sales and technical team leader for the IBM PC Institute
in EMEA, based in Basingstoke, UK. He has worked for IBM for 10 years and
has been with the PC Institute team for three years teaching and developing
courses for PSG products. Before joining PC Institute, he worked with the
server marketing teams producing marketing collateral and other
deliverables. He also held the position of National Language Support
coordinator for PC Server products. Sonny is a Microsoft Certified
Professional and an IBM Professional Server Specialist. He holds a Bachelor
of Science degree with honors in Computer Studies from London University.

Sutikno Lukito is a PC/NW System Services Specialist in Indonesia. He has
six years of experience with IBM hardware and software. He holds a degree
in Electrical and Electronic Engineering from Surabaya University. His areas
of expertise include Netfinity servers, operating systems, and technical
support. Sutikno is a co-author of the redbook Netfinity Server Management,
SG24-5208.
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project:

Barbara B. Barker, Netfinity Director development, Raleigh
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Comments welcome

Your comments are important to us!

We want our Redbooks to be as helpful as possible. Please send us your
comments about this or other Redbooks in one of the following ways:

• Fax the evaluation form found in “IBM Redbooks review” on page 203 to
the fax number shown on the form.

• Use the online evaluation form found at ibm.com/redbooks

• Send your comments in an Internet note to redbook@us.ibm.com
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http://www.redbooks.ibm.com/contacts.html
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Chapter 1. Introduction

Netfinity Director is the new IBM Netfinity systems management software
product. It is now easier to use and contains greater functionality than the
existing Netfinity Manager product offering.

Netfinity Director can coexist with Netfinity Manager and Netfinity Services
products. Both products can function independently and some integration of
Netfinity Manager into a Netfinity Director configuration is possible to provide
discovery, alerts, and inventory from Netfinity Manager clients. This
integration is made possible by installing the Netfinity Multi-Platform Manager
(MPM) Provider along with the Netfinity Director product. This interface acts
as a gateway to reach native Netfinity Manager systems from Netfinity
Director.

Beyond coexistence and integration, the transfer of customer configuration
data (for example, alerts and schedules) from Netfinity Manager to Netfinity
Director is largely a manual process. This redbook will help you through this
process by providing information on where the information is stored, and
worksheets to let you record your configuration data.

There are a number of reasons why you should convert your Netfinity
Manager configuration to Netfinity Director:

• Windows 2000 support.

Netfinity Manager does not support Windows 2000 either as a manager or
as a client. If you wish to manage Windows 2000 systems, you must use
Netfinity Director.

• Support for new systems.

While support for Netfinity Manager will remain beyond 2000 through
fixpacks, it is possible that newer systems will not be supported by
Netfinity Manager.

• Centralized security.

Netfinity Manager is a peer-to-peer configuration and access from one
system to another is based on passwords stored in both systems. With
Netfinity Director all client access is controlled through the Netfinity
Director server, either using existing Windows user IDs as a basis for
access, or with user IDs created within Netfinity Director, or a combination
of both. Netfinity Director offers a higher level of user ID and password
security by integrating with the Windows Security Accounts Manager
(SAM) database.
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• Improved interface and functionality.

The new Netfinity Director user interface is much easier to use and is
based on a drag-and-drop Explorer-like interface rather than the older
OS/2-Windows 3.1 iconic interface of Netfinity Manager. Netfinity Director
is based on Tivoli’s IT Director and, as such, offers a greater level of
functionality over Netfinity Manager.

Netfinity Director does not support older systems that do not have SMBIOS
(systems management BIOS) 2.0 support. If you have older systems that
don’t have this support, you may wish to maintain both Netfinity Manager and
Netfinity Director: use Netfinity Director to manage all the new systems and
use Netfinity Manager (either with or without MPM) to manage all the older
systems.

This redbook provides you with the following information to help you migrate
from Netfinity Manager to Netfinity Director:

• How the two products compare, what the system prerequisites are and
what the licensing issues are for Netfinity Director

• What you should do to plan for a migration

• How to install the Netfinity Director server and console

• How to use MPM to manage Netfinity Manager systems from Netfinity
Director

• How to install Netfinity Director clients, both attended and unattended

• What customer configuration data is stored in your Netfinity Manager
systems, where it is stored, and steps to transfer that information to
Netfinity Director

• Reasons to remove Netfinity Manager once Netfinity Director is running
and how to do so

• How IT Director compares with Netfinity Director and how to upgrade
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Chapter 2. Comparing Netfinity Director with Netfinity Manager

This chapter introduces Netfinity Director and compares it with Netfinity
Manager.

Netfinity Director is a new product that will replace Netfinity Manager. It is
based on Tivoli IT Director and can be easily upgraded to IT Director to
receive the full benefits of Tivoli systems management. Netfinity Director is
designed to manage a small-to-medium sized environment of up to 1,500
licensed clients with one management server.

In comparison to Netfinity Manager, Netfinity Director adds many features,
such as a completely redesigned user interface, dynamic rules-based
grouping and an integrated database, so the system information is still
accessible even when the managed client is offline.

Using the Java-based graphical user interface, an administrator can manage
individual or groups of IBM and non-IBM Intel processor-based server,
desktop, workstation and notebook systems on a variety of platforms. It is
designed to use industry-standard information-gathering technologies and
messaging protocols, including Common Information Model (CIM), Desktop
Management Interface (DMI), and Simple Network Management Protocol
(SNMP).

Leveraging these standards, Netfinity Director can integrate into enterprise
and workgroup management systems including:

• Tivoli Enterprise Framework
• Tivoli NetView NT
• Computer Associates Unicenter TNG Framework
• Microsoft SMS
• Intel LANDesk Management Suite

2.1 Components

A Netfinity Director configuration is made up of three main components as
shown in Figure 1:

• Netfinity Director server
• Netfinity Director console
• Netfinity Director clients
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In addition, Netfinity Director can be extended to have additional functions
through the use of plug-ins, known as Life Cycle Tools, such as UM Server
Extensions.

Each of these is now described.

Figure 1. A typical Netfinity Director configuration

2.1.1 Netfinity Director server

The server is the heart of Netfinity Director. This is where the management
data, server engine, and management application logic reside. The
management information is stored in a database (Jet, SQL Server or DB2).
Only one server to needed to manage up to 1500 clients.

The server can be either a Windows NT 4.0 or a Windows 2000 Server
system. Installation is described in Chapter 4, “Installing Netfinity Director
server and console” on page 45. When you install the server component, the
client and the console components are automatically installed as well.

If this system is a Netfinity server or if any managed system is a Netfinity
server, you should also install UM Server Extensions.

Netfinity Director console
Contains:

Console
UM Server Extensions
UMS (optional)

Netfinity Director clients
Each contains:

UMS
UM Server Extensions
(Netfinity servers only)

Netfinity Director server
Contains:

Server
UMS
Console
UM Server Extensions

61
55

-0
0

TCP/IP

Various
protocols
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A license is required for the server.

The server and the console communicate via TCP/IP. The server can
communicate with the clients using any of the following network protocols:

• NetBIOS
• Novell IPX
• TCP/IP
• SNA/APPC

2.1.2 Netfinity Director console

The console is the user interface for Netfinity Director and is where all
administrative tasks are performed. You can have as many consoles as you
need, since these do not require software licenses.

The console can be any WIN32 system (Windows 95, 98, NT 4.0 or 2000).
Installation is described in Chapter 4, “Installing Netfinity Director server and
console” on page 45. When you install the console, UMS is not installed
automatically — if you want to manage the console system, you must also
install UMS. If you are have any Netfinity servers in your network, you should
also install UM Server Extensions.

2.1.3 Netfinity Director agent

The agent is installed on all systems to be managed, including the console
and the server. The agent is known as UM Services (UMS) which is a
Tivoli-ready set of services. Netfinity Director recognizes two types of
managed systems:

• Native Netfinity Director systems: these have an agent installed and act as
a passive system. Users of these systems do not have access to a GUI.

• Multiplatform Manager (MPM) systems: these are PCs or devices that are
running Netfinity Manager and communicate with Netfinity Director via an
MPM provider.

UMS runs on the following operating systems:

• Windows 2000 (Professional, Server and Advanced Server)
• Windows NT 4.0 Workstation or Server (with Service Pack 4 or higher)
• Windows 95 (OSR 2 or later) and Windows 98
• NetWare 4.x with Service Pack 5 or higher
• NetWare 5.0 with Service Pack 1 or higher
• SCO UnixWare 7.1
• OS/2 4.0 with Service Pack 5
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• OS/2 Warp Server for e-business

Notes:

• All systems must have a BIOS that supports SMBIOS Version 2.0 or
higher.

• The Universal Management Agent (UMA) is not supported by Netfinity
Director.

UMS installation is covered in Chapter 6, “Installing UMS on clients” on page
93. If the client is a Netfinity server, you should also install UM Server
Extensions as well.

2.1.4 UM Server Extensions

Netfinity Director is an extensible system through the use of Life Cycle Tools
(LCT). One of these is UM Server Extensions, a set of tools for use on
Netfinity servers. UM Server Extensions is installed on the following systems:

• Each Netfinity server
• Each Netfinity Director console
• The Netfinity Director server (even if it isn’t a Netfinity system)

UM Server Extensions includes:

• Advanced System Management

Server problems happen for a number of reasons:

– Applications with memory leaks
– Failing or soon to fail hardware
– Unstable applications
– Everyday use

Advanced System Management through the service processor gives you
control of remote systems. You can monitor critical subsystems, restart
logs, and troubleshoot Netfinity servers, even if the targeted system is not
powered on.

• Capacity Manager

As the number of users of server applications increases so does the
server resource use. Over time, this can result in an application failure due
to resource depletion. Capacity Manager tracks resource utilization,
identifies multiple levels of existing or potential bottlenecks, and makes
recommendations to improve performance.
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• Cluster Systems Management

IBM Cluster Systems Management (ICSM) is used to help you control, set
up, and manage clustered servers from a single graphical user interface.
Systems administrators can be alerted to any event in a cluster (hardware,
operating system, and MSCS).

• Netfinity SP Switch administration

The Netfinity SP Switch is resilient to failure due to redundant components
and an integrated service processor. The Netfinity SP Switch
Administrator monitors the operating status of various switch components
by providing proactive alert notification if a component should fail.

• RAID Manager

This tool reduces the time needed to configure and to manage ServeRAID.
Hot spares are reduced with the new RAID 5E support, which reserves
space on existing drives for rebuilds. Data scrubbing and auto
synchronization of the parity drive can be done remotely. RAID migration
enables migration from previous RAID levels to increase free space and
logical drive space.

• Software rejuvenation

Cumulative application software errors affect the availability of your server.
Through a calendar interface, Software Rejuvenation allows refreshing of
the software on your MSCS clustered nodes.

• Fibre Channel Storage Manager

The Enterprise Management windows provides the following primary
storage management functions:

– Discover hosts and storage subsystems on your local subnetwork, to
add to your management domain

– Manually add or remove hosts and storage subsystems to your
management domain

– Provide the ability to sort rows in the device table according to different
criteria

– Store your enterprise management windows view preferences and
management domain data in local configuration files

– Monitor the condition of storage subsystems and report a high-level
status using appropriate icon

– Configure alert notifications (e-mail or SNMP traps) and report critical
events to the configured alert destinations
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– Load the appropriate subsystem management window for a selected
storage subsystem to allow detailed configuration and management
operations

– Execute a script to perform batch management tasks on a particular
storage subsystem

UM Server Extensions is available from the Web at:

http://www.ibm.com/pc/ww/solutions/enterprise/sysmgmt/products

For information on how to install UM Server Extensions see 6.4, “Installing
UM Server Extensions” on page 117.

2.2 Differences between the products

The most significant visible difference between Netfinity Manager and
Netfinity Director is the user interface. Netfinity Manager was loosely based
on an OS/2-style iconic interface, while the Netfinity Director is based on a
hierarchical tree-oriented interface as shown in Figure 2. The components of
the main window are:

• Menu bar, used to set up the configuration and preferences setting.
• Tool bar containing icons for easy access to key functions.
• Groups panel, a list of all the groups of systems.
• Group Contents panel, a list of systems in the currently selected group.
• Tasks panel, the functions that can be performed on groups or systems.
• Status bar, where actions are acknowledged, and the name, logon userid

and server time and date are displayed.
• Ticker tape, where you can monitor system attributes without having to

view a separate window. The ticker tape can contain information about
specific systems or conditions and serves as a status indicator, providing
real time monitoring of critical resources.

Functions are performed by dragging tasks from the task panel onto either a
group in the Groups panel, or a system in the Group Contents panel.

Tasks are discussed in 2.3, “Netfinity Director functions” on page 14.
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Figure 2. Netfinity Director Console

2.2.1 Architecture

Aside from the user interface enhancement, Netfinity Manager and Netfinity
Director are fundamentally different in the way they operate, as shown in
Figure 3 on page 10:

• Netfinity Manager uses peer-to-peer communications to establish a
connection between a manager system and a client system. Information
about the connection and related security are stored in both the manager
and the client systems, but not in any central location. Any one manager
does not have to be able to directly connect to all systems — it can
connect to remote systems by first connecting to an intermediate system,
then “leap frogging” to the remote client. No dedicated central server is
used.

• Netfinity Director operates in a client/server system management
configuration. The configuration uses a dedicated server acting as the
core engine for the environment that keeps all the data about all systems.
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All requests to access any clients from a management console are passed
through the server.

Data about the systems, such as inventory, is collected at the server in an
SQL database. This enables an administrator to simply perform queries on
the data to obtain information about all systems regardless of the current
state of those systems.

Figure 3. Comparing the architectures of Netfinity Manager and Netfinity Director

2.2.2 Security

Netfinity Manager uses application-level security, configured using the
Security Manager. On each system, you create user IDs and passwords that
allow access to specific Netfinity Manager functions.

Netfinity Director uses a centralized security model, storing all security
access information on the Netfinity Director server. Security is implemented
at two levels:

• User-logon security. This controls which users can log on to a Netfinity
Director console and what functions they can perform. This is discussed in
more detail in this section and in the Netfinity Director Installation and
User’s Guide.

Netfinity Director: centralized server and database
that has access to all systems. A console can then
connect to the server to access any client.

Netfinity Manager: clients are managed
by connecting directly or via another
go-between system.

6
15

5-
00
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• Agent-server security — defines trust relationships between the agent and
one or more servers through the use of public and private keys. This is
discussed in detail in the Netfinity Director Installation and User’s Guide.

Access to the Netfinity Director console is implemented through the Console
Security function (click Options > Console Security from the console
window). The console security window initially displays a table of all user IDs
that are authorized to access the Netfinity Director server. You can:

• Define general access, group access, and task access privileges
• Add a new user ID
• Edit the information of an existing user ID
• View the list of user IDs defined in Netfinity Director

Users can be defined in two ways:

• Create the user using Console Security in Netfinity Director. You can use
this option if you want a group of administrators to access Netfinity
Director all with the same user ID and password. These are known as
non-native user accounts.

• Create the user using Windows NT/2000’s User Manager on the Netfinity
Director server. The user’s ID and password are controlled through the
operating system’s security functions. This means that Netfinity Director
administrators need to remember only their Windows password. These are
known as native user accounts.

To allow a native user account to have access to Netfinity Director, the
user must be a member of one of the following groups on the Netfinity
Director server:

– Administrators (local administrators)

– Domain Admins (if the Netfinity Director server is part of a domain)

– TWGAdmins (a group created when the Netfinity Director server is
installed as shown in Figure 4)

– TWGSuperAdmins (a group created when the Netfinity Director server
is installed as shown in Figure 4)

Native user accounts that are members of Administrators, Domain
Admins, and TWGAdmins can have their access to specific tasks and
systems limited through settings in Console Security. Native user accounts
that are members of TWGSuperAdmins have complete access to all tasks
and systems and cannot be restricted.

Note: You would normally add users to the TWGAdmins or
TWGSuperAdmins groups only when you want them to be Netfinity
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Director administrators but you do not want them to be Windows local or
domain administrators.

Figure 4. Two Netfinity Director administrator groups defined in Windows

Notes:

• The account that was used to install Netfinity Director server is
automatically made a member of TWGAdmins and TWGSuperAdmins.

• By default, local administrators, domain administrators and TWGAdmins
do not have access to the Console Security function. This means that only
members of TWGSuperAdmins can change user access to the console.
This can be changed by adding the privilege Allow user account
administration in Console Security.

• Membership in the TWGAdmins and TWGSuperAdmins groups does not
give you the authority to start or stop the Netfinity Director server service
(TWGIPC). This requires specific operating system authorities and is not
controlled within Netfinity Director.

Once the console users have been defined, access can be restricted to
specific groups and tasks. See 7.2, “Security Manager” on page 130 for more
information.
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2.2.3 Groups

Netfinity Manager uses keywords to determine a group. When you define a
group, you specify what keywords should be present in each machine to be
included in the group. You can also filter the groups based on the networking
protocol used and the operating system of the client.

In Netfinity Director, groups can be defined based on “rules” including the
hardware and software inventory of the clients. Groups can be:

• Dynamic groups — group membership changes as clients change and is
automatically updated.

• Static groups — once defined, the contents of these groups never change

• Task-based groups — groups that contain members that can all have
specific tasks performed on them (for example, Advanced System
Management)

Netfinity Director does not use keywords to define groups.

For details about Netfinity Director group management, please refer to
section 3.3 of the redbook Netfinity Director Integration and Tools,
SG24-5389.

2.2.4 Wake On LAN

Netfinity Director supports Wake on LAN. This is enabled by selecting the
Enable Wake-On-LAN checkbox during client installation as shown in Figure
5:

Figure 5. Netfinity Director Network Driver Configuration
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To access this window:

• On the Netfinity Director server, the window appears automatically during
installation. To access it later, click Start > Programs > IBM Netfinity
Director > Network Driver Configuration.

• On UMS systems other than the Netfinity Director server, it is not
displayed during installation. You can start it by running TWGIPCCF from a
command line (the directory where it is installed, C:\Program
Files\IBM\Director\bin, is in the path statement)

2.3 Netfinity Director functions

This section describes how to perform Netfinity Manager functions in Netfinity
Director.

The main window is divided into three panels as shown in Figure 6.

• Groups — contains predefined and administrator-defined groups, similar
to the Remote Systems Manager in Netfinity Manager

• Group Contents — the contents of the currently selected group

• Tasks — all the tasks that are available from this console. If UM Server
Extensions is installed on this console, the additional tasks will be shown

Before you can manage clients, you have to find or discover them. To launch
the discovery process, click Tasks > Discover Systems > All Systems and
Devices.
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Figure 6. Netfinity Director console

The functions that appear in the Tasks panel are discussed briefly below.
Table 1 lists the Netfinity Manager functions and the equivalent Netfinity
Director functions.

Table 1. Equivalent Netfinity Manager functions in Netfinity Director

Netfinity Manager functions Netfinity Director tasks

Advanced System Management Advanced System Management

Alert Manager Event Action Plan

Alert Log Event Log

(Not implemented) CIM Browser

Alert Manager Configure Alert on LAN

(Not implemented) Configure SNMP Agent
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Complete instructions on how to use each of these services can be found in
the online help provided with the product. The following manuals are

Capacity Manager Capacity Manager

Critical File Monitor (Not implemented)

DMI Browser DMI Browser

Dynamic Connection Manager Advanced System Management

Event Scheduler Task Scheduler

File Transfer File Transfer

Fibre Channel Storage Manager Fibre Channel Storage Manager

Power-On Error Detect (Not implemented)

Predictive Failure Analysis SMART

Process Manager Process Management

Remote System Manager Group pane

Remote Session (Not implemented)

Remote Workstation Control Remote Control

RAID Manager RAID Manager

Screen View (Not implemented)

Security Manager Console Security

Service Configuration Manager Event Action Plan Builder

Software Inventory Inventory

(Not implemented) SP Switch Administrator

System Information Inventory

System Monitor Resource Monitor

System Profile Asset ID and the TWGUSER.INI file

Update Connector Manager Update Connector Manager

Web Manager (Not implemented)

(Not implemented) Software Distribution

Netfinity Manager functions Netfinity Director tasks
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available in PDF format in the DOCS directory of the Netfinity Director
CD-ROM:

• NFDBOOK.PDF — Netfinity Director Installation and User’s Guide
• QUICKBOOK.PDF — Netfinity Director Quick Beginnings
• UMSBOOK.PDF — UM Services User’s Guide

You can initiate tasks in different ways, including:

• Dragging and dropping icons
• Right-clicking on tasks or systems
• Selecting operations from pull-down menus

To use the drag-and-drop techniques, drag the desired task icon from the
Tasks pane and drop it onto the desired managed system icon in the Group
Contents pane or vice versa.

To apply the task for more than one system at a time, hold down the Shift
and/or Ctrl key, click on a range of systems then drag the task from the Tasks
panel and drop it on any of the highlighted managed systems in the Group
Contents pane.

Table 2 shows what tasks can be carried out with Netfinity Director V2.12 on
the different client operating systems that are supported.

Table 2. Netfinity Director tasks supported by the operating systems

Windows 9x Windows NT Windows 2000 OS/2 NetWare SCO

Inventory Yes Yes Yes Yes Yes Yes

Monitors Yes Yes Yes Yes Yes Yes

Events Yes Yes Yes Yes Yes Yes

Software Distribution Yes Yes Yes Yes No No

Process Manager Yes Yes Yes Yes Yes Yes

Remote Control Yes Yes Yes Yes No No

Cluster Manager No Yes Yes No No No

File Transfer Yes Yes Yes Yes Yes No

DMI Browser Yes Yes Yes No No No



18 Migrating from Netfinity Manager to Netfinity Director

The remainder of this section introduces the tasks that are available.

2.3.1 Advanced System Management

In Netfinity Manager, the Advanced System Management service is
implemented through the Advanced System Management icon. It enables
communication between Netfinity Manager and the Advanced System
Management processors and adapters. It can be used to configure and
monitor many of your system's features. With the Advanced System
Management service, you can configure events such as POST, loader, and
operating system time-outs, critical temperature, voltage, and tamper alerts,
and redundant power supply failures. This service also enables you to dial
out and directly access and control a remote system's Advanced System
Management processor or adapter.

Netfinity Director does the same functions as shown in Figure 7. The
difference is in the connection options. You can establish a TCP/IP
connection in Netfinity Director, similar to Dynamic Connection Manager in
Netfinity Manager.

Note: Netfinity Director currently doesn’t support serial connections via
Advanced System Management.

CIM Browser Yes Yes Yes No No No

Upward Integration1 Yes Yes Yes No No No

1 Upward Integration refers to point-to-point management only. Alerts from Netfinity Director can be sent
from all operating systems.

Windows 9x Windows NT Windows 2000 OS/2 NetWare SCO
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Figure 7. Advanced System Management window

2.3.2 Asset ID

Similar to the System Profile service in Netfinity Manager, the Asset ID task
shows you information on your IBM hardware. Asset ID comes with the base
Netfinity Director installation and uses SMBIOS to obtain information about
the client.

Systems that support radio-frequency ID technology (RF ID) can scan this
information with a special radio frequency scanner and if there is a change in
the configuration, Asset ID can send a DMI compliant alert. UMS Asset ID
can store information into the DMI database if no EEPROM is present on a
system. Asset ID information is divided into the following sections. These are
tabs in the Asset ID window as shown in Figure 8.

• Serial numbers
• System information
• User information
• Lease information
• Asset information
• Personal information
• Warranty information
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Figure 8. Asset ID window

For more details about Asset ID, see:

http://www.pc.ibm.com/ww/assetid/index.html

2.3.3 Capacity Manager

Capacity Manager has the same function in both Netfinity Manager and
Netfinity Director, which is to automatically monitor and store data of the
performance of your system. The previous month’s data is automatically
recorded on each client and you can use the Capacity Manager to gather this
data from multiple systems on your network to generate reports and to
perform analysis on the systems’ throughput.

For comprehensive information on how to use Capacity Manager, see
Chapter 12 of the redbook Tuning Netfinity Servers for Performance —
Getting the most out of Windows 2000 and Windows NT 4.0, SG24-5287.

2.3.4 CIM Browser

The Common Information Model (CIM) is a set of methodologies and
syntaxes (also called a language) that describes the management features
and capabilities of hardware or software components.

CIM is a standard defined by the Distributed Management Task Force
(DMTF). The CIM model is implemented in systems using Managed Object
Format (MOF) files. It means each hardware component or piece of software
that is CIM-compliant must be provided with its set of MOF files to be
managed. See Figure 9.

http://www.pc.ibm.com/ww/assetid/index.html
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Figure 9. CIM window

The CIM Browser is part of Netfinity Director and it is installed during the
normal installation of the console. The CIM layer is also part of UMS and is
installed during the UMS installation.

Note: To provide CIM data, managed systems must be running under
Windows 95, 98, Windows NT 4.0 or Windows 2000 and have Windows
Management Interface (WMI) core services Version 1.1 installed. The WMI
core services are installed with Netfinity Director.

For more information about the standards and descriptions of the
management features and capabilities see http://www.dmtf.org.

2.3.5 Configure Alert on LAN

In Netfinity Manager, this function enable alerts to be sent to a network
administrator if a system problem occurs, no matter whether the system is

http://www.dmtf.org
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powered on or off. Alert on LAN only appears on machines that have the Alert
on LAN hardware. An alert will be sent if there is a cover intrusion, processor
removal, power or network plug removal, fan speed problems, temperature
and detected voltage problems.

Alert on LAN 2, the next release of Alert on LAN, is included in Netfinity
Director and extends the capabilities to remotely manage and control
networked PCs:

• Remote system reboot upon report of a critical failure
• Repair operating system
• Update BIOS image
• Perform other diagnostic procedures

Alert on LAN 2 allows a management console to work directly with a PC. Alert
on LAN proxy tool was installed in the network by using the Netfinity Director
Workgroup/ Enterprise integration option. For more details about Alert on
LAN, go to http://www.pc.ibm.com/us/desktop/alertonlan/index.html.

2.3.6 Configure SNMP Agent

The SNMP configuration tool is used to perform actions on SNMP trap
destinations, as shown in Figure 10:

• Add new community names and new SNMP trap destinations
• Edit existing SNMP trap destinations
• Remove existing community names and SNMP trap destinations

http://www.pc.ibm.com/us/desktop/alertonlan/index.html
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Figure 10. Configure SNMP Agent window

This tool works in Windows 95, Windows 98, Windows NT and Windows 2000
environments. UMS forwards the SNMP traps only if the SNMP agent is
installed on both the server and the client workstation. You can install and
configure the SNMP agent as part of the UMS installation process or by using
the operating system installation CD.

Note: If you install the SNMP agent for Windows 95 or Windows 98 after
UMS has been installed, you must use the SNMP trap configuration tool to
add the trap destinations to the registry.

2.3.7 DMI Browser

The Desktop Management Interface (DMI) enables you to examine
information about DMI-compliant hardware and software products that are
installed on your system. A DMI layer is installed as part of UMS so that the
browser can have access to that layer. The DMI layer can also come from
third parties such as Intel (go to http://www.intel.com and search for
DMISL.EXE).

http://www.intel.com
http://www.intel.com
http://www.intel.com
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Netfinity Manager comes with DMI Version 1.0, and Netfinity Director comes
with a new version, DMI V2.0s, and is shown in Figure 11. DMI is supported
only on Windows 95/98, Windows NT and Windows 2000.

Figure 11. DMI Browser window (Netfinity 8500R)

2.3.8 Event Action Plans

The Event Action Plans task is the equivalent of the Alert Manager in Netfinity
Manager.
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Figure 12. Event Action Plan Builder console

In Netfinity Manager, Alert Manager had two main functions:

• Maintain a log of all events (alerts) that are received and logged by the
system management software.

• Execute predefined responses or user-specific responses (actions) to
specified events.

In Netfinity Director, event and alert management consists of three main
components:

• Event manager configuration — lets you create an action plan to handle
the specific types of events and alerts, and respond with specific actions.

• Event action plan builder — allows you to associate events and alerts with
action plans and manage systems and devices.

• Event log — allows you to view the events and alerts that are saved in the
log, as described in 2.3.9, “Event Log” on page 26.

Defining alerts and action plans are explained in 7.1, “Alert Manager” on
page 122.

More details can be found in section 6.2.3.1 “Event Action Plan Builder” of the
redbook Netfinity Director Integration and Tools, SG24-5389.
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2.3.9 Event Log

In Netfinity Manager, all alerts are shown in the alert log, which enables you
to view a log of events that have occurred in the managed system or group of
systems.

In Netfinity Director, you can find this function in the Event Log task. Any
event that happen within the system can be intercepted by the agent and
forwarded to the Netfinity Director server. Events can be classified in terms of
severity. By default Netfinity Director defines seven event filters:

• All Events
• Critical Events
• Fatal Events
• Harmless Events
• Minor Events
• Unknown Events
• Warning Events

You can build your own event filter based on your needs. For details about
event management, see 7.1, “Alert Manager” on page 122.

For more information, see section 3.3.2.1 of the redbook Netfinity Director
Integration and Tools, SG24-5389.

2.3.10 File Transfer

In Netfinity Manager, you can use the file transfer service to easily send,
receive, or delete files or directories, synchronize directories, or remotely
clean up the remote or Client Services systems in your network.

Netfinity Director offers simple file transfer functions, and can also perform
additional functions, such as creating directories and renaming files. It does
not have the ability to perform directory synchronization or remote cleanup
assistance.

2.3.11 IBM Cluster Tools

Netfinity Manager supports the cluster management service only when the
MSCS is installed on your system.

In Netfinity Director, the IBM cluster tools user interface and function have not
been changed. Double-clicking this icon will start IBM Cluster Systems
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Management, the IBM tool for improved MSCS management. IBM cluster
tools are divided into two separate tools:

• Cluster System Management, for cluster management tools

• Software Rejuvenation, the tool to schedule tasks onto a cluster node or
reboot a node in a cluster.

2.3.12 Inventory

As a combination of Software Inventory, System Information and System
Profile in Netfinity Manager, Netfinity Director allows you to collect hardware
and software inventory on a group of systems or on an individual system.
Furthermore, you will get more functions than you have in Netfinity Manager:

• Group operations
• Create your own queries
• Store query results in HTML format

Netfinity Director collects information from discovered managed systems and
stores the information in the inventory database on the Netfinity Director
server. You can then view and analyze collected hardware and software
inventory data and customize the display.

2.3.13 Microsoft Cluster Browser

The function only lets you view your MSCS-based cluster. To manage the
cluster, use the IBM Cluster Tools component as described in 2.3.11, “IBM
Cluster Tools” on page 26.

2.3.14 Process Management

This task lets you start, stop or monitor applications and processes on remote
systems. You can also start, stop, pause, and resume Windows NT/2000
services and devices. You can configure Netfinity Director to watch a
particular process or application and generate an event when the application
or process is started or terminated.

The key feature of Netfinity Director and Netfinity Manager is the ability to
manage individual processes on remote systems. The Process Management
tasks of Netfinity Director and Netfinity Manager function lets the
administrator view and manipulate all applications or processes. The system
administrator will be able to set monitors for a specific process or application
so that if an application or process terminates, an event (alert) will be
generated. That means if a process stops or starts, you can configure the
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process management or process manager to send an alert. Based on the
contents of the alert you can run a script that can do anything from restarting
the application to notifying the help desk.

For more information, see 3.2.8 “Process Management” in Netfinity Director
Integration and Tools, SG24-5389.

2.3.15 Remote Control

To access and control managed nodes remotely for troubleshooting and
problem resolution, both Netfinity Director and Netfinity Manager support
remote control. The equivalent function in Netfinity Manager is Remote
Workstation Control. There are no significant differences between the ways
they support it.

Netfinity Director has an easy way to start it by using drag and drop, while
Netfinity Manager requires you to click through several icons to access the
remote system and then log onto the system.

2.3.16 Resource Monitor

This task offers functions similar to System Monitor in Netfinity Manager
although the interface is different. Resource Monitor lets you view statistics
and usage of resources on the network, information on attributes such as the
CPU, disk, memory, and network protocols that are collected and monitored.
On Windows NT/2000 systems, you can monitor any Performance Monitor
counter. You can also set thresholds, records monitored data, generate
graphs, and generate events when thresholds are exceeded.

For more information, see 3.2.4 “Resource Monitoring” in Netfinity Director
Integration and Tools, SG24-5389.

2.3.17 Scheduler

The scheduler is accessed by clicking the button in the console main
window.

You can schedule tasks on an hourly, daily, weekly, monthly or yearly basis.
Tasks can be triggered by changes in the managed system status, or by the
discovery of new hardware or software in the network. In addition, you can
schedule tasks for individual managed systems or by groups of managed
systems.
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See 7.4, “Event Scheduler” on page 143 in this book and 3.2.7 “Task
scheduling” in the redbook Netfinity Director Integration and Tools,
SG24-5389 for more information.

2.3.18 ServeRAID Manager

The ServeRAID Manager task is a comprehensive management tool that lets
you monitor and perform actions on a ServeRAID subsystem through
Netfinity Director. It has a similar interface to the CD-ROM based configurator
that is shipped with the ServeRAID adapters and is a significant improvement
over the RAID Manager in Netfinity Manager.

For details, see Chapter 6 of the UM Server Extensions User’s Guide.

2.3.19 Software Distribution

The software distribution task is a menu to build a software distribution
package that you can distribute to a system, group of system, or a group. This
feature is not fully supported by Netfinity Director. You only have limited
predefined packages, such IBM UM Server Extensions. You cannot build new
packages.

Software distribution is discussed in detail in 6.3, “Software distribution
through MPM” on page 112.

2.4 What is missing in Netfinity Director

Several functions are not available in Netfinity Director:

• Critical File Monitor, which can issue an alert whenever critical files are
deleted or altered.

• Web Manager, which lets you access most Netfinity Manager functions
through a browser. With Netfinity Director, the Web browser is not
supported as a console because current browsers do not support the level
of Java used in the Netfinity Director console. UMS offers Web-based
management — this function can be installed when UMS is installed on
the client.

• Remote Session, a text-based command-line session. The closest
function is the Remote Control task as described in 2.3.15, “Remote
Control” on page 28.
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• Screen View, a snapshot of a remote Netfinity Manager system. The
closest function in Netfinity Director is the Remote Control task as
described in 2.3.15, “Remote Control” on page 28.
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Chapter 3. Planning to migrate

Before you begin the process of converting your Netfinity Manager
environment to Netfinity Director, it is very important that you understand the
four high-level stages that can aid in structuring your migration plan.

The major reasons companies are moving to Netfinity Director are stability,
ease-of-use, availability of support for new hardware and operating systems
(Windows 2000 for example), and better integration with higher-level
enterprise systems management software. This chapter looks at planning the
move.

3.1 Deployment

When rolling out Netfinity Director, companies have two main options:

• Coexistence with Netfinity Manager
• Complete migration, replacing Netfinity Manager

Choosing how to migrate from Netfinity Manager to Netfinity Director is not a
straightforward decision. Companies with significant Netfinity Manager
expertise and supported hardware understandably want to protect their
investment. In large environments, investment in PCs will also affect the
deployment method:

• As a company turns over older PCs and replaces them with new PCs, it is
normal to install the latest software on them. Therefore, a strategy of
coexistence may be more appropriate.

• If a company upgrades its PC population in one large rollout, then it may
be possible to migrate to the new version without having to manage the
old product as well.

Ultimately, the economics of the transition play a large role in the decision of
when to deploy Netfinity Director:

• Size of company and dependency on Netfinity Manager
• Time frame
• Complexity of existing environment
• State of legacy systems
• Geographic dispersion
• Skills of staff
• Cost of hardware
• Cost of software licenses
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3.1.1 Coexistence

This is the piecemeal deployment of Netfinity Director into an existing
Netfinity Manager environment. Coexistence will have less impact on the
existing environment and is more common in larger companies.

Many companies follow a technology-refresh cycle, and at any point in time,
10-40% of their systems can be at the end of their life. They can gradually
introduce newer systems with Netfinity Director, which allows them to test,
verify and fine tune the deployment of Netfinity Director and not incur the
transition costs of replacing their entire environment all at once.

Alternatively, when purchasing new hardware or moving to a different
operating system (for example, Windows 2000), customers will require
systems management software that will support both the new hardware and
software.

Integration has the lowest impact on the environment and allows users and
support staff to ease into a Netfinity Director environment. The disadvantage
to this method is that it is the slowest and adding machines in “ones and
twos” may not be the optimal way to manage a new environment.

3.1.2 Migration

Complete migration or cutover, moving the entire Netfinity Manager
environment to Netfinity Director, is typically used in smaller companies or for
complete projects that are fairly autonomous from the rest of the environment
where, due to their size, the impact to the environment is mitigated by the
speed of the transition. Complete migration will have a higher transition cost
because the entire environment is being moved, but a lower maintenance and
support cost due to having a homogeneous systems management platform.

An example where a project can be migrated to Netfinity Director could be
where the IT manager considers that to achieve the highest levels of
performance, a move to newer software applications is required that could be
made to coincide with a move to a different operating system platform (for
example, Windows 2000). Netfinity Director software is capable of supporting
both the new hardware and software.

An alternative way to carry out a complete migration from Netfinity Manager
to Netfinity Director is to build the new project environment from the ground
up with new hardware and software. This method is attractive to small
enterprises that want to completely divest from their old systems environment
because they often can build a parallel environment. There are many benefits
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to migrating directly to Netfinity Director at this time, the main one being the
existence of only one systems management application to support. This
would lead to reduced complexity, easier data-sharing, and increased tasks
that can be applied.

With complete migration, the entire system management solution is moved
from Netfinity Manager to Netfinity Director. Changes will also include cabling
and connections to the network/server because we are moving from a
peer-to-peer environment to a client/server environment. All Netfinity Director
clients must be directly accessible from the Netfinity Director server.

The advantage of this method is that it provides a true test bed for the new
Netfinity Director environment while giving visibility to the new applications
and new operating system. The disadvantage to this method is that it can
create many segregated subnetworks within a company.

Total migration is the most extreme transition and can cause the most
short-term disruption. However, it is also the cleanest.

3.2 Implementation road map

To help the implementation process go smoothly, it is good to have a road
map. This section contains a road map to assist you in making the Netfinity
Director transition. The road map contains four stages to facilitate the
deployment process:

1. Planning
2. Design
3. Implementation
4. Training

3.2.1 Planning

This first stage of the process is crucial. A thorough understanding of the
limitations of your existing environment, the goals of the future environment,
and the steps to get there is essential for a smooth transition.

• Decide when the migration can occur

Understand the life cycle of your current environment. Look for technology
refresh opportunities. It’s possible that a high percentage of systems are
changing at any one time, so if you can look for these opportunities to
move to Netfinity Director, this will lessen the impact on your organization,
and shorten the investment recovery period.
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• Determine what need to be changed

Develop a strategic plan for the transition including systems units,
network/cabling and all hardware, as well as software, operating system
components, and personnel.

• Decide which method you’ll use

Make a decision on how to deploy (coexistence or migration, or a
combination of the two) and how extensive the deployment will be
(project-based or enterprise-wide).

• Decide when Netfinity Manager will be “turned off”

If you are planning to have both Netfinity Manager and Netfinity Director
running at the same time (either completely independently or integrated
through MPM), you may want to set a time frame as to when Netfinity
Manager is removed from your systems.

• Who will do the work?

Determine who in your organization (or services companies such as IBM
Global Services) will be doing the remainder of the project.

3.2.2 Design

Once the decision to move has been made and the high-level planning
accomplished, the next step is to determine how implementation will be done.
This design stage will answer the what and how questions. The result of this
phase should be a blueprint for the implementation phase. The majority of the
research, analysis and system design should take place during the design
phase.

• Determine the sequence of the rollout

The server will be installed first, followed by clients and consoles. Decide
if a test environment will be created first, where all functions can be
verified as working as expected.

Netfinity Manager is a peer-to-peer environment. You could manage a
remote system by first connecting to an intermediate system then
“hopping” to the remote system. Netfinity Director is a client/server
environment where all clients are managed directly from the server.

This may mean that you’ll have to change how your systems are
connected together.

Connectivity between systems
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• Verify that client prerequisites are met

Determine if the proposed clients are sufficiently powerful. 32 MB of
system memory is sufficient for the default UMS configuration. However, if
more UMS options are selected, 64 MB of system memory is
recommended.

Verify that all clients support SMBIOS 2.0 or later. See 3.4.4, “Netfinity
Director client (UM Services)” on page 39 for information on how to check
for SMBIOS support.

• Select the server

Determine computing needs for the Netfinity Director server. Refer to 3.4,
“Supported systems” on page 37.

• Determine if the network capacity and topology is sufficient

Verify that network infrastructure will not be a bottleneck for the new
technology. The number of clients that can be efficiently managed by
Netfinity Director can vary according to existing network load and the
functions being performed. System discovery, frequent presence checks,
and alert usage will increase network traffic. Since Netfinity Director uses
a central server to gather and store all client data, the data traffic
characteristics will be different from those of Netfinity Manager.

Use tools such as Performance Monitor or Capacity Manager to determine
what load Netfinity Manager puts on the network. This information can
then give you an idea as to what to expect with Netfinity Director.

The system that you select to be the Netfinity Director server needs to be
able to connect to every client through one of the supported protocols.
Ensure that your network is set up to allow this.

• Decide how client rollout will occur

Decide how to install UMS on the workstations. For information see
Chapter 6, “Installing UMS on clients” on page 93.

Decide if MPM will be used so that Netfinity Manager clients can be
managed by Netfinity Director. See Chapter 5, “Coexistence using MPM”
on page 57 for details about MPM and 3.5.1, “MPM licensing” on page 43
for information about licensing aspects of MPM.

• Netfinity Director consoles

Consoles should be placed where convenient to administrators but not in
unsecured locations.

Determine who will be able to access Netfinity Director and how security
will be implemented. You can either create administrator user IDs in
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Netfinity Director or you can use existing Windows user IDs defined at the
server or you can use a combination of both of these. See 2.2.2, “Security”
on page 10 for details.

• Determine if all tasks you use in Netfinity Manager are still available in
Netfinity Director

See Table 1 on page 15 for a comparison of tasks between the two
products. If any of the tasks you use are not available in Netfinity Director,
see what alternative (and potentially better) methods exist to perform the
same task.

• Check if there are better ways to perform old tasks in Netfinity Director

Evaluate how tasks are currently performed in Netfinity Manager and find
out if it’s still the best way to do the task or if Netfinity Director offers an
alternative method that is more efficient.

• Testing and signoff

Develop a testing strategy to ensure that all functions are working
properly. This testing should assist in identifying limitations and
bottlenecks. See Table 2 on page 17 for a list of tasks supported by each
operating system.

Develop a backout plan if any part of the rollout is unsuccessful. You
should ensure that all your systems remain manageable throughout the
entire process.

Get agreement that once the products are rolled out and certain tests are
completed successfully, the rollout project is completed and can be signed
off.

3.2.3 Implementation

The implementation stage is where all of the transition activity takes place.
The process should be straightforward provided you’ve designed a complete
rollout strategy.

• Install the server
• Rollout UMS to the clients
• Install the consoles
• Test the installation

3.2.4 Training

In conjunction with the implementation phase, you should also provide
training to those who will be administering the new Netfinity Director system.
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The IBM PC Institute team in your country offers a variety of training classes
for hardware and software. They deliver both Web-based online training and
technical hands-on workshop classes. The Web site for details is:

http://www.ibm.com/pc/training/

• For the online systems management training courses click on Online
Training on the Web page (free registration required).

• The instructor-led hands-on one-day technical class is IBM Netfinity
Director Workshop, course code TNI08. This course covers many of the
scenarios for Netfinity Director Integration/Migration discussed in this
redbook. Click Course Catalog for details.

3.3 Support

The following Netfinity Director support is available:

• A Web-based forum and e-mail-based support for Netfinity Director and
related products, accessible from the IBM Enterprise Support Web page
at:

http://www.ibm.com/pc/ww/solutions/enterprise/support

This support, monitored by IBM personnel, includes a search facility to
quickly locate previous postings on Netfinity Director and UM Services
related topics.

• The e-mail-based TechConnect list (which covers all topics related to
Netfinity):

http://www.pc.ibm.com/techconnect/tech/forum.html

3.4 Supported systems

Netfinity Director V2.12 is supported on most of the current IBM systems:

• Netfinity servers
• IntelliStation workstations
• IBM PC desktops
• ThinkPad notebooks

For the latest list of IBM systems supported, see the combination of the
following:

• The ServerProven Compatibility page:

http://www.pc.ibm.com/us/compat/applications/matrix.shtml 

http://www.ibm.com/pc/training/
http://www.pc.ibm.com/us/compat/applications/matrix.shtml
http://www.ibm.com/pc/ww/solutions/enterprise/support
http://www.pc.ibm.com/techconnect/tech/forum.html
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• The Netfinity Director product announcement:

http://www.ibmlink.ibm.com/usalets&parms=H_200-084 

Non-IBM systems are also supported, but the client must support SMBIOS
2.0 to be able to install UMS.

3.4.1 Operating system summary

Table 3 summarizes the supported operating systems:

Table 3. Operating systems supported by Netfinity Director V2.12

3.4.2 Netfinity Director server

Netfinity Director server has the following minimum hardware requirements:

• Pentium II 300 MHz or faster

Operating System NFD Server NFD Console UMS Agent

Windows 2000 Professional, Server and Advanced
Server

Yes Yes Yes

Windows NT 4.0 with SP4+ Yes Yes Yes

Windows 2000 Terminal Services and Windows NT 4.0,
Terminal Server Edition (the server itself)

No No No1

Clients of Windows 2000 Terminal Services and
Windows NT 4.0, Terminal Server Edition

No No No1

Windows NT 3.51 No No No

Windows 95 SR2 or 98 No Yes Yes

Windows 3.11 (not supported) No No No

NetWare 5.0 with SP1+ No No Yes

NetWare 4.1, 4.11 with SP5+ (SFT III not supported) No No Yes

NetWare 3.x (not supported) No No No

OS/2 4.0 with FixPak 5+ No No Yes

OS/2 Warp Server for e-business No No Yes

SCO UnixWare 7.1 (with patch ptf7441a) or later No No Yes

Note:

1 Support for UMS on Windows 2000 Terminal Services and Windows NT 4.0, Terminal Server edition is
planned for a future release.

http://www.pc.ibm.com/us/compat/applications/matrix.shtml
http://www.ibmlink.ibm.com/usalets&parms=H_200-084
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• 128 MB system memory
• 150 MB virtual memory
• 300 MB free disk space

Netfinity Director server has the following software requirements:

• Operating systems as per Table 3
• TCP/IP for connectivity to the Netfinity Director console

The following databases are supported:

• Microsoft JET 4.0 (included)
• Microsoft SQL Server 6.5 and 7.0
• IBM DB2 Universal Database 5.2

3.4.3 Netfinity Director console

Netfinity Director console has the following minimum hardware requirements:

• Pentium II 300 MHz processor or faster
• 64 MB RAM
• 60 MB free disk

Note: The system does not need to support SMBIOS 2.0 to run the Netfinity
Director console.

Netfinity Director console has the following software requirements:

• Operating systems as per Table 3 on page 38
• TCP/IP for connectivity to the Netfinity Director server

3.4.4 Netfinity Director client (UM Services)

UMS has the following minimum hardware requirements:

• Specific IBM systems listed in the ServerProven and IBM announcement
letter Web pages as listed above

• Non-IBM systems that are compatible with SMBIOS 2.0 or above
• Pentium class processor
• 64 MB RAM (more if optional features are selected during installation)
• 16 MB disk space (more if optional features are selected during

installation)

The System Management BIOS (SMBIOS) is a specification which, when
implemented in a computer’s BIOS, lets you export some management data
in a standard table format. Instrumentation software can then retrieve the
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information and use it for management purposes. SMBIOS is based on the
WfM 2.0 specification.

The Wired for Management (WfM) specification, published by Intel is the
result of the industry initiatives to define a common platform to make
computers easily manageable. WfM covers BIOS, hardware, software, and
instrumentation requirements, and can be considered as a reference source
for developers of management applications.

A BIOS with management abilities is a critical requirement since it is the only
code that can detect configuration and system settings, particularly during the
boot stage. The types of data exported by SMBIOS include the following:

• Information related to the manufacturer of the computer
• Characteristics of the present processors
• Information related to physical slots, memory type, and system enclosure

For more information about SMBIOS and to download software that can do
compatibility checks see:

http://www.ibm.com/products/surepath/other/smbios.html

The test utility SMBIOS2.EXE, available from this Web site lets you
determine what revision of SMBIOS your system supports. Run the
command:

SMBIOS2 /I

This shows the SMBIOS Entry Point Structure, which includes the revision
level. On a system with SMBIOS support you will see something similar to the
following:

http://www.ibm.com/products/surepath/other/smbios.html
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Figure 13. Output of the SMBIOS2 /I command showing support for SMBIOS 2.1

If your client doesn’t support SMBIOS, you’ll see the following output:

Figure 14. A system without SMBIOS support

UMS has the following software requirements:

• Operating systems as per Table 3 on page 38

• Optionally, one of the following Web browsers for direct access to a client
running UMS:

– Microsoft Internet Explorer 4.01 or later
– Netscape Communicator 4.5 or later
– Netscape Navigator 4.5 or later

• One of the following network protocols:

– TCP/IP
– NetBIOS
– IPX
– SNA

SMBIOS 2.1 Structure Table Entry Point Structure (at FDFCh:0000h):
  Anchor String                = _SM_
  Checksum                     = 64h
  Entry Point Structure Length = 1Fh bytes
  SMBIOS Revision              = 2.1
  Maximum Structure Size       = 283 (decimal) bytes
  Entry Point Revision         = 0
  Formated Area:
        Reserved            = 0 0 0 0 0
DMI BIOS Structure Entry Point Structure (at FDFDh:0000h):
  Header                       = _DMI_
  Checksum                     = 7Eh
  Length                       = 067Ah (1658 decimal) bytes
  BIOS Structure Table Address = 000F7B93h
  Number of Structures         = 44
  DMI BIOS Revision            = 2.1

No valid DMI BIOS Structure Entry Point Structure found in F0000h-FFFFFh!



42 Migrating from Netfinity Manager to Netfinity Director

3.5 Licensing

The components of Netfinity Director are licensed as follows:

• Netfinity Director server: A license is required for each server. Each
Netfinity Director server can manage up to 1500 clients.

• Netfinity Director console: No licenses are required. There is no limit to the
number of consoles supported.

• UMS clients:

– IBM systems: No licenses are required
– Non-IBM systems: A Netfinity Director client license is required
– MPM systems: A Netfinity Director client license is required. See 3.5.1,

“MPM licensing” on page 43

• Life cycle tools. Licensing depends on the vendor. IBM’s UM Server
Extensions and UM Desktop Extensions do not require licenses.

The following Netfinity Director licenses are shipped with Netfinity servers:

• One license of the server code
• 20 Netfinity Director client (UMS) license for non-IBM systems or systems

connected through MPM

If you received IBM Netfinity Manager with your Netfinity server, you can
upgrade to Netfinity Director for a small fee. For details, see:

http://www.pc.ibm.com/ww/netfinity/systems_management/nfdirfulfill.html

The set of 20 client licenses shipped with a Netfinity server cannot be
combined with sets of licenses shipped with other Netfinity servers to allow
more than 20 non-IBM or MPM connections. If you need more than 20, you
must order additional licenses as per Table 4.

For example: A customer buys 12 Netfinity 5600 systems, each shipping
with a copy of Netfinity Director. They could install Netfinity Director on
each of these 5600s and manage up to 240 non-IBM (or MPM) systems.
However, it is more usual to install only a single copy of Netfinity Director
server on one 5600, which will entitle them to manage only 20 non-IBM or
20 MPM systems.

Licenses shipped with Netfinity servers cannot be combined

http://www.pc.ibm.com/ww/netfinity/systems_management/nfdirfulfill.html


Chapter 3. Planning to migrate 43

If you require more licenses, you can order them using the following part
numbers:

Table 4. Additional licenses

3.5.1 MPM licensing

As described in Chapter 5, “Coexistence using MPM” on page 57, MPM lets
you manage Netfinity Manager systems from Netfinity Director. The use of
MPM has specific licensing implications:

• Each MPM client (that is, each Netfinity Manager system to be managed
using Netfinity Director via MPM) counts as one license key.

• If a non-IBM client has both Netfinity Manager and UMS installed, and you
are managing the system using both UMS and MPM, this requires two
client licenses. If you’re managing the system with UMS or MPM but not
both, then only one license is required.

If a supported IBM system has both UMS and Client Services for Netfinity
Manager installed, a license is not required to manage it from Netfinity
Director via UMS. If you have MPM support installed and have discovered
these systems, you may see multiple instances of the same system (one for
UMS and one for Client Services via MPM).

You can revoke the license consumed by MPM for that system by
right-clicking on the MPM version of the discovered system and clicking
Revoke License. This will then make the license available for another
system.

UMS agent is supported on the systems with SMBIOS 2.0 or greater meeting
Intel Wired for Management (WfM) 2.0 specification. However, if a system
does not have SMBIOS 2.0 or greater it can still be managed by Netfinity
Director as an MPM agent. However, all MPM systems take up a non-IBM
client license even though the system could be an IBM system.

Product Part number

Netfinity Director V2.12 with 20 client licenses 41L2940

Netfinity Director V2.12 with 20 client licenses (upgrade) 41L2941

20 additional client licenses 11K6314

100 additional client licenses 11K6315

1000 additional client licenses 11K6316
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Note: if MPM agent systems are discovered multiple times by the MPM
Provider (that is, because the MPM Provider and agent are running more than
one network protocol) then a client license will be consumed for every
instance of a system.

A summary of licensing is shown in Table 5. Here, you can see how many
client licenses are required based on:

• IBM or non-IBM system
• SMBIOS 2.0 system
• UMS client or MPM client
• The number of network drivers enabled between the MPM client (Netfinity

Manager) and the MPM Provider

Table 5. Determining how many client licenses are required

3.5.2 IT Director licensing

If you plan to upgrade your Netfinity Director system to Tivoli IT Director, you
must purchase a license for each client. This includes IBM systems, OEM
systems, non-SMBIOS systems, and MPM systems. The upgrade is sold by
certified Tivoli resellers and is available through the IBM Passport Advantage
program.

IBM
system

SMBIOS
V2.0+

UMS agent MPM
system

Number of network
drivers enabled

Client licenses
required

Yes Yes Yes No n (1 or more) 0

Yes Yes Yes Yes n n

Yes Yes No Yes n n

Yes No No Yes n n

No Yes Yes No n 1

No Yes No Yes n n

No No No Yes n n

No Yes Yes Yes n n+1 (i.e. 2 or more)
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Chapter 4. Installing Netfinity Director server and console

This chapter describes how to install Netfinity Director server and Netfinity
Director console on your machine.

As described in 2.1, “Components” on page 3, the Netfinity Director server is
the center of the management configuration. All transactions pass through
the server and a database is used to keep data about every client. The
Netfinity Director console is the administrator’s user interface to the Netfinity
Director server.

When you install Netfinity Director server, the console and UMS software are
also installed. When you install the console, UMS is not installed.

The hardware and software prerequisites are listed in 3.4, “Supported
systems” on page 37.

4.1 Before you begin

Before you begin the installation of the server make sure that you are logged
on as an administrator or an ID with equivalent privileges. Consider the
following when deciding which user ID to use for installation:

• The server service will always start using the user account you are logged
on with during installation. You may want to consider creating a specific ID
to use for starting services (perhaps even create a separate ID for each
service). This is useful for security requirements such as changing
passwords.

• If you are logged on as a domain user, you must be a domain
administrator to install the Netfinity Director server database properly. If
you are not a domain administrator, log on locally to the system with local
administrator rights.

• If you are logged on as a local administrator during installation, Netfinity
Director server will use the local administrator for starting the Netfinity

If you are upgrading your server and consoles from Netfinity Director 2.11
to Netfinity Director 2.12, you must uninstall 2.11 before you begin the 2.12
installation. See section 3 of the README.TXT on the installation CD for
more information.

Upgrade from 2.11
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Director Support Program, and will use the local accounts database for
Console Security. If you are logged on as a domain administrator during
installation, Netfinity Director server will use domain administrator for
starting the Netfinity Director Support Program, and will use the domain
accounts database for Console Security.

• If you are using a domain user ID to start the service, and you authorize a
Windows NT/2000 user to access the Netfinity Director console, that user
will be authorized for all management servers using a user account from
the same domain (since that ID is added to the TWGAdmins or
TWGSuperAdmins domain group).

4.2 Installing the server

The Netfinity Director installation can be started either by inserting the CD
into the CD-ROM drive or by executing ibmsetup.exe
(X:\win32\install\ibmsetup.exe). And follow the steps as below:

1. Click Next in the Welcome window and the License Agreement.

2. The Select Components window appears, where there are four different
installation choices, as shown in Figure 15:

– Server — installs the server, console and UMS code
– Console — installs the console
– Client — installs UMS
– Workgroup/Enterprise Integration — to install software to enable UMS

to communicate with Enterprise Managers such as CA Unicenter TNG,
Tivoli, and Microsoft SMS

Notes:

– If you have Netfinity Director 2.11 installed you must completely
uninstall the server and consoles before you install this product. See
section 3 of the README.TXT file on the CD-ROM for details.

– If you have a beta level of Netfinity Director installed you must
completely uninstall the beta code before you install this product.

– When you run the installation program on a Windows 95/98 system,
you will only see the Console and Client buttons. You cannont install
the server on these systems.
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Figure 15. Select Components window

3. Click the Server button. This will install UMS, server, and console.

4. The first component to be installed is the UMS code. Figure 16 appears
asking which options you want. See 6.1, “Installing UMS” on page 93 for
details about this window.

Figure 16. UMS Client Configuration window
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Select the components you want installed and click Next.

5. If you selected Web Based Access, Figure 17 appears.

Figure 17. User ID for Web access window

Here, you need to provide a user ID for browser access to the UMS client.
You can also select the IP port number (the default is 411). Make sure that
the selected port is not used by other TCP/IP applications.

Note: Figure 17 is asking for a user ID to access UMS from a browser.
This is not related to Netfinity Director console access. Currently, you
cannot access the Netfinity Director console from a browser.

6. Click Next to continue and the installation routine prompts you if you want
to add a Netfinity Director icon to the Start menu.

7. Now the installation of the server component begins. If you are installing
the Netfinity Director server, you will then be prompted to enter a license
key for the server software. You do not need a license for the console nor
the client code. Click Next.

8. Specify the directory where you want the server and console code placed
then click Next. The default is C:\Program Files\IBM\Director\

Note: If you are planning to manage a large number of clients, the
database stored in this directory can become very large (upwards of
1 GB). Ensure you have sufficient space on the selected drive.
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9. Now you are prompted for a directory to put the software distribution
packages. Click Next to accept the default directory, C:\Program
Files\IBM\Director\SwDistPk\.

10.Now you are prompted for the directory where the software distribution
packages that are installed on this system will be placed. Click Next to
accept the default directory, C:\Program Files\IBM\Director\SwDistPk\

11.You are prompted if you want to install files for remote control.

12.You are prompted if you want to install files for a TMR Gateway. Click Yes
only if there is Tivoli management agent software installed on the network.

13.The system begins installing the necessary files, then the NT Account
Information window opens, shown in Figure 18. Enter your Windows
account password, then click Next to continue.

Note: The user ID displayed is the ID that you logged on with before
beginning the installation. This is used to set the security for the database
and cannot be changed in the future.

Figure 18. Windows account information window

14.The Director Database Configuration window opens, shown in Figure 19.
This is where you select which DBMS you wish to use to store the Netfinity
Director database. Click the button next to the appropriate database for
the installation.

The default button (the top one in Figure 19) installs a Microsoft Jet
database system.
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Note: The Jet database is suitable only for managing up to about 1000
users. If you plan to manage large numbers of users, you should select
SQL Server or DB2.

Figure 19. Director Database Configuration window

15.The Network Driver Configuration window opens, shown in Figure 20.

Enable the appropriate network driver by selecting the driver from the
Network Drivers list and check the Driver Enabled checkbox. You may
change the Network Timeout if desired. Also select the Required User
Authorization for Screen Access checkbox if you want to give client
users the authority to deny the system administrator remote control
access to their machine. This option allows users to control who accesses
their machines. Select the Enable Wake-On-LAN checkbox if the agent
system has Wake on LAN capability. Then select OK to continue.
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Figure 20. Network Driver Configuration window

Note: To access this window on the server later, click Start > Programs >
IBM Netfinity Director > Network Driver Configuration.

16.The installation is now complete. Reboot the system.

17.The server status can be monitored via an icon in the lower-right portion of
your desktop (taskbar). The program that shows this status indicator is
TWGSRVST.EXE, which gets started from the Windows StartUp folder.
The icon shows Netfinity Director’s status as follows:

Table 6. Server status icon

If you double-click the taskbar icon, you get information as shown in Figure
21.

Note: The server must be fully started (as shown by a green circle in the
taskbar), before you can log on to the server.

Status icon Description

The server is inactive

The server is starting

Server startup has completed successfully
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Figure 21. Netfinity Director Server Status

18.After the system is installed, the following options are added to the Start
menu, under IBM Netfinity Director:

– Management Console
– Network Driver Configuration
– View readme

19.If you have installed or plan to install UM Server Extensions on any
Netfinity server system in your network, you must also install UM Server
Extensions on the Netfinity Director server as described in 6.4, “Installing
UM Server Extensions” on page 117.

To start the console click Start > Programs > IBM Netfinity Director >
Management Console. The Netfinity Director Login window appears, as
shown in Figure 22.

Note: Ensure the server is fully started before you log on to the console.
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Figure 22. Netfinity Director Login window

For more information about installation, see Chapter 2 of the redbook
Netfinity Director Integration and Tools, SG24-5389.

4.3 Installing the console

The Netfinity Director installation can be started either by inserting the CD
into the CD-ROM drive or by executing ibmsetup.exe
(X:\win32\install\ibmsetup.exe). And follow the steps below:

1. Click Next in the Welcome window and the License Agreement.

2. The Select Components window appears, where there are four different
installation choices, as shown in Figure 23:

– Server — installs the server, console and UMS code
– Console — installs the console
– Client — installs UMS
– Workgroup/Enterprise Integration — to install software to enable UMS

to communicate with Enterprise Managers such as CA Unicenter TNG,
Tivoli, and Microsoft SMS

Notes:

– If you wish to manage the system where you plan to install the console,
you should install UMS before you install the console. However, if you
do not plan to manage the console (for example, if you are installing
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the console on a non-SMBIOS system), then you do not need to install
UMS.

– If you have Netfinity Director 2.11 installed you must completely
uninstall the 2.11 console before you install this product. See section 3
of the README.TXT file on the CD-ROM for details.

– If you have a beta level of Netfinity Director installed you must
completely uninstall the beta code before you install this product.

– When you run the installation program on a Windows 95/98 system,
you will only see the Console and Client buttons.

Figure 23. Select Components window

3. Click the Console button. This will install the console only (not UMS).

4. Specify the directory where you want the console code placed then click
Next. The default is C:\Program Files\IBM\Director\

5. The code is now copied to your hard disk.

6. Once the installation is complete, reboot the system.

7. The following options are added to the Start menu, under IBM Netfinity
Director:

– Management Console
– Uninstall
– View readme
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8. If you have installed or plan to install UM Server Extensions on any
Netfinity server system in your network, you must also install UM Server
Extensions on the Netfinity Director console as described in 6.4, “Installing
UM Server Extensions” on page 117.

To start the console click Start > Programs > IBM Netfinity Director >
Management Console. The Netfinity Director login window appears, as
shown in Figure 24.

Note: Ensure the server is fully started before you log on to the console.

Figure 24. Netfinity Director Login window

For more information about installation, see Chapter 2 of the redbook
Netfinity Director Integration and Tools, SG24-5389.



56 Migrating from Netfinity Manager to Netfinity Director



© Copyright IBM Corp. 2000 57

Chapter 5. Coexistence using MPM

The Multi-Platform Manager (MPM) initiative is used to define an open and
consistent way to allow different system management solutions to work
together extending the level of control between a higher-level workgroup or
enterprise management to PC LAN management tools. You may think of
MPM as a translator for management applications.

The MPM API is an open industry initiative that was developed with
representation from many of the leading industry companies including Tivoli
Systems, Intel Corporation, Microsoft, and Novell. They provided review,
input, and guidance to the MPM specification. There is a consideration to
propose it before an open standards group such as the DMTF.

There are three components to the MPM environment:

• MPM Broker. This component resides on the Netfinity Director server and
allows the server to send and receive messages between each MPM
Provider. It is installed as part of the installation of the Netfinity Director
server.

• MPM Provider. This is also known as the MPM Site or the Netfinity
Provider. It performs the translation of information between Netfinity
Manager and Netfinity Director and allows the two to communicate. It is
installed during the installation of UMS or Netfinity Director on systems
where Netfinity Manager is already installed and running.

Note: The MPM Provider cannot be a Windows 2000 system because it
must be running Netfinity Manager. Netfinity Manager is not supported on
Windows 2000.

• MPM Agents. These are the Netfinity Manager systems that communicate
with the MPM Broker via the MPM Provider.

The two scenarios covered in this chapter describe the two possible
situations as shown in Figure 25:

• Scenario 1: the MPM Provider is on a system with Netfinity Manager and
UMS installed, and the MPM Broker is on a separate Netfinity Director
system, the Netfinity Director server.

• Scenario 2: the MPM Broker and the MPM Provider are on the same
system, the Netfinity Director server.
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Figure 25. MPM scenarios

These two scenarios are discussed later in this chapter.

We recommend you use scenario 1 because it keeps the Netfinity Director
server code separate from the MPM environment. This makes it easier to
migrate completely to Netfinity Director, removing all traces of Netfinity
Manager and the MPM Provider.

5.1 What you can do with MPM?

Netfinity Director V2.12 has the ability to manage the clients of Netfinity
Manager using the MPM API. MPM acts as a gateway to other Netfinity
Manager systems and lets them be managed by Netfinity Director.

Note: The tasks capable of being applied to these MPM agents are only a
subset of the tasks applicable to Netfinity Director agents running UMS.

The use of MPM means you can perform the following tasks on MPM agents:

• Discovery of MPM systems
• Hardware and software inventory
• Event management
• Remote program execution within event action plans
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• Software distribution

Streaming mode only: that is, software is distributed directly from the
Netfinity Director sever to the client. You cannot configure a distribution
server to alleviate bandwidth problems.

These are discussed in 5.5, “Managing MPM systems” on page 77.

5.2 Before you begin

Before installing the Netfinity Director server and UMS, do the following:

• Understand the licensing implications of using MPM. See 3.5.1, “MPM
licensing” on page 43.

• Select the Netfinity Manager system that will be the MPM Provider.

– The MPM Provider cannot be a system running Client Services for
Netfinity Manager. It must be running the full Netfinity Manager
software.

– If you plan to use scenario 1 as described above, it is likely that you’ll
use an existing Netfinity Manager system.

– If you plan to use scenario 2, the MPM Provider will also be your
Netfinity Director server, so you may want to consider using a new
dedicated Windows NT system. You cannot use Windows 2000
because Netfinity Manager is not supported on that operating system.

• On the MPM Provider, ensure that Netfinity Manager is installed and
running. Ensure that the NETFBASE process is running.

• On the MPM Provider system, start Netfinity Manager and discover all
Netfinity Manager systems.

The discovery does not have to be performed before the MPM
configuration is set up, but it needs to be done before Netfinity Director
“sees” any of the Netfinity Manager systems. It also aids as a test to
ensure that the Netfinity Manager configuration is working properly.

The next version of Netfinity Director after Version 2.12 may not include
support for MPM. The implications of this are that there will no longer be
any integration with Netfinity Manager from Netfinity Director.

Support for MPM
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Note: Netfinity Director will recognize all systems in all groups in Netfinity
Manager. You do not have to define special groups in Remote System
Manager.

• If you are using scenario 1, select a system that will act as the MPM
Broker. This system will have Netfinity Director server installed on it. See
3.4, “Supported systems” on page 37 for prerequisites.

Our Netfinity Manager lab configuration is shown in Figure 26. We have
selected NFM_NTS4 (top right in the figure) to be the MPM Provider.

Figure 26. Existing Netfinity Manager environment

The next two sections describe the two scenarios where MPM can be used to
integrate Netfinity Director with Netfinity Manager:

• Scenario 1: Install UMS with the MPM provider on an existing Netfinity
Manager system and install Netfinity Director server with the MPM broker
on a new system.

• Scenario 2 (page 70): Install Netfinity Director server and UMS on an
existing Netfinity Manager system. In this scenario, the MPM Broker and
the MPM Provider are on that same system.

NFM_NTS4_1
Windows NT Server 4.0
Service Pack 6a
Netfinity Manager 5.20.6

NFM_NTS4
Windows NT Server 4.0
Service Pack 6a
Netfinity Manager 5.20.6

NFM_NTS4_2
Windows NT Server 4.0
Service Pack 6a
Netfinity Manager 5.20.6

NFS_NTW
Windows NT Worstation 4.0
Service Pack 6a
Netfinity Client Services 5.20.6

NFS_NW
NetWare 4.11
Fixpack 5
Netfinity Client Services 5.20.6

NFM_OS2
OS/2 Warp Server
Netfinity Manager 5.20.6

NFS_W98
Windows 98
Netfinity Client
Services 5.20.6
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5.3 Scenario 1

In this scenario, we install UMS with the MPM provider on an existing Netfinity
Manager system and install Netfinity Director server with the MPM broker on
a separate system.

We recommend this method because it keeps the Netfinity Director server
separate from the MPM Provider. This makes it easier to migrate completely
to Netfinity Director, removing all traces of Netfinity Manager and MPM
Provider.

Figure 27. Scenario 1

In our lab, we used a Netfinity Server 8500R system running Windows 2000
as the Netfinity Director server.

The overall steps are as follows:

1. Install UMS on one of the Netfinity Manager systems
2. Install the Netfinity Director server
3. Configure MPM on the Netfinity Director server

NFM_NTS4 (MPM Provider)
Netfinity Manager 5.20.6
Install:

UMS

Other Netfinity
Manager systems

New system (MPM Broker)
Windows 2000
Netfinity Director server
Netfinity Director console
UMS
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5.3.1 Install UMS on one of the Netfinity Manager systems

The first step is to install UMS on the selected Netfinity Manager system that
will be the gateway to the other Netfinity Manager systems. In our lab setup,
we selected NFM_NTS4 as shown in Figure 27.

Note: The MPM Provider must have the full Netfinity Manager installed and
running, not just Client Services for Netfinity Manager. Netfinity Manager
must be running (that is, the NETFBASE process must be running).

1. Log on as a local administrator and install UMS. Run the Netfinity Director
installer and click the Client button as shown in Figure 28:

Figure 28. Installing the Netfinity Director client

2. When you see Figure 29 during the client installation, ensure that
Netfinity Director Support is selected. This installs the MPM Provider.
The MPM Provider lets you use Netfinity Manager as a gateway to reach
other systems that only have Netfinity Manager installed.

Click the Client
button to install
UMS.
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Figure 29. UMS configuration window

3. Continue the installation as described in 6.1, “Installing UMS” on page 93.

4. Once UMS is installed, you are prompted reboot the system. However,
you can delay this reboot until step 7.

5. Run NFPRVCFG.EXE from the directory where it is installed. By default,
this is C:\Program Files\IBM\UMS\Director\bin. Figure 30 appears.

Figure 30. Configuring the MPM Provider for inventory collection

6. Check both Collect Software Inventory and Check Hardware Inventory
and adjust the Refresh Period as you feel appropriate for you installation.

Select Netfinity
Director Support
to install the MPM
Provider.
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7. Reboot the system.

Note: If you run NFPRVCFG.EXE at a later stage, you will need to do the
following befor your changes to take affect:

– Reboot the MPM Provider system
– Remove the MPM Provider from the active list in the Netfinity Director

console, then re-add it again.

8. Start Netfinity Manager and discover all systems via Remote Systems
Manager.

Note: You do not need to create any specific group. Using the All group
will be sufficient as Netfinity Director will “see” all systems from all
Netfinity Manager groups on the MPM Provider systems.

Now that the Netfinity Manager system has UMS installed, complete with the
MPM provider, the next step is to bring online the new Netfinity Director
server and configure it.

5.3.2 Install Netfinity Director server

Here, we install Netfinity Director server and discover the MPM Provider we
created in the previous step.

1. Install Netfinity Director server, Netfinity Director console, and UMS on
the system you’ve selected (in our lab, we’ve selected a Netfinity 8500R
running Windows 2000).
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Figure 31. Installing Netfinity Director server

2. Follow the server installation instructions in 4.2, “Installing the server” on
page 46.

3. Reboot the system once the installation is complete.

4. Start the Netfinity Director console and log on to the server. (If you can’t
log on, make sure the server has fully started and try again.)

5. From the console, discover the MPM Provider (and all other systems) by
clicking the Discover All Systems button, or click Task > Discover
Systems > All Systems and Devices. In our lab, as shown in Figure 32,
only the two systems with UMS installed are discovered. These are:

– The 8500R server running Netfinity Director server
– The NFM_NTS4 system running UMS, which we have configured to be

the MPM Provider

Note: At this point the other Netfinity Manager systems are not detected
by the Netfinity Director server. These will be discovered after MPM has
been configured.

Click the
Server button
to install the
server, console
and UMS
components.
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Figure 32. Discovering the MPM Provider and other UMS systems

5.3.3 Configure MPM

The next step is to configure MPM on the Netfinity Director server so that it
can discover the Netfinity Manager systems via the MPM Provider.

1. From the Netfinity Director console, click Options > Discovery
Preferences. Click the MPM Sites/Providers tab. Figure 33 appears.

Only the systems
running UMS are
discovered at this
point.
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Figure 33. MPM Providers found by Netfinity Director

We can see that system NFM_NTS4 is recognized as an MPM Provider. It
is possible to have more than one provider if you have installed UMS on
multiple Netfinity Manager systems. However, this is unnecessary since all
systems in that environment can be discovered at the same time

Note: Netfinity Director supports only MPM Providers on Netfinity
Manager systems. MPM Providers from other products such as Intel
LANDesk are support by IT Director but not Netfinity Director as described
in Chapter 9, “Upgrading to IT Director” on page 165.

2. Highlight the MPM Provider and click Add. The MPM Provider is then
added to the list of Active MPM Providers as shown in Figure 34

Figure 34. Active MPM Providers

3. Click the MPM Systems tab. Here, you can specify how often you want
Netfinity Director to look for new Netfinity Manager systems. Figure 35
appears.
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Figure 35. Setting the auto-discover period

4. Specify the number of hours between discoveries. The auto-discover
function is disabled by default. We have set our auto-discover to occur
every 24 hours.

If you also have auto discovery enabled in Netfinity Manager on the MPM
Provider, then the combination of both auto discovery settings will ensure
that Netfinity Director can automatically detect any new Netfinity Manager
systems.

5. Click OK. This will initiate an MPM discovery on the selected MPM
Provider, which finds the other Netfinity Manager systems, as shown in
Figure 36.

The system in the angled brackets (for example, <NFM_NTS4>) is the name
of the MPM Provider that was used to detect each Netfinity Manager
system.
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Figure 36. Netfinity Director has detected all Netfinity Manager systems via the MPM Provider

The following new entries appear in the console as shown in Figure 36:

a. Two new groups are created:

• IBM Netfinity(tm) Systems
• MPM Systems

These groups are, in fact, identical in membership. MPM Systems is all
clients discovered by any MPM system. IBM Netfinity Systems is all
Netfinity Manager systems discovered via MPM. Since Netfinity
Director supports only Netfinity Manager-based MPM Providers, these
groups are the same.

b. The MPM clients are discovered.

These are the systems that were discovered by Netfinity Manager in
5.2, “Before you begin” on page 59.

Systems discovered via
MPM. The system in the
angled brackets <...>
specifies the MPM
Provider that was used
as the gateway.

Two new groups are
added: all Netfinity
Manager systems
and all MPM systems
(equivalent).
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These MPM systems can now be managed from Netfinity Director.

Notes:

• Netfinity Manager must be started before Netfinity Director starts. To do
this, either increase the value of the StartUpDelay registry key for Netfinity
Director, or add a DependOnService registry key to make TWGIPC
dependent upon NETFBASE.

• If you do not see the Netfinity Manager systems, ensure that Netfinity
Manager is running on the MPM Provider and that all systems have been
discovered in Netfinity Manager on that system.

• If the systems are listed more than once in the Group Contents panel, this
may be due to each client connecting to the server with more than one
network protocol (for example, NetBIOS and TCP/IP).

Now that the system is configured, you can manage these Netfinity Manager
systems from Netfinity Director as described in 5.5, “Managing MPM
systems” on page 77.

5.4 Scenario 2

In this scenario, we install Netfinity Director server and UMS on an existing
Netfinity Manager system. Here, the MPM Broker and the MPM Provider are
on that same system.

Select a Netfinity Manager system that will be your Netfinity Director server
system. You may want to consider a new server for this. In our lab, we have
selected NFM_NTS4 as shown in Figure 37:
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Figure 37. Scenario 2

The main steps are:

1. Install Netfinity Director server
2. Configure MPM on the server

5.4.1 Install Netfinity Director server

Install Netfinity Director server on a system that already has Netfinity
Manager installed and running.

1. Install Netfinity Director server (this also installs UMS and the console) on
the selected Netfinity Manager system. In our lab, we used NFM_NTS4.
See 4.2, “Installing the server” on page 46 for specifics.

2. During the server installation, you are prompted to install the Netfinity
Provider as shown in Figure 38. This component provides the MPM
interface between Netfinity Manager and Netfinity Director. Make sure the
component is selected before continuing.

NFM_NTS4 (MPM Broker & Provider)
Netfinity Manager 5.20.6
Install:

Netfinity Director server
Netfinity Director console
UMS

Other Netfinity
Manager systems
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Figure 38. Installing the Netfinity Provider

3. The installation continues. Figure 39 will appear. Ensure that both Collect
Software Inventory and Collect Hardware Inventory are selected.
Adjust the Refresh Period as you feel appropriate — the minimum refresh
period is one hour.

You must have Netfinity Manager already installed and running when
you install Netfinity Director. If it isn’t running, you will not see Figure 38
where you can install the Netfinity Provider.

Netfinity Manager must be running
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Figure 39. MPM Provider inventory settings

Note: You can access this window after the installation is complete by
running Start > Programs > IBM Netfinity Director > MPM Provider for
Netfinity Configuration or by running NFPRVCFG.EXE. If you make
changes, you must restart Netfinity Manager.

4. Complete the installation of Netfinity Director and reboot the system.
When the system reboots, the Netfinity Director server will start. Wait for
the server to fully start before continuing.

5.4.2 Configure MPM

The next step is to configure Netfinity Director to detect the MPM clients.
Remember that the Netfinity Director server and the MPM Provider are the
same system (unlike Scenario 1):

1. Start the Netfinity Director console and log on to the server. (If you can’t
log on, make sure the server has fully started and try again.)

2. From the console, discover all systems by clicking the Discover All
Systems button, or click Task > Discover Systems > All Systems
and Devices.

You’ll see that the MPM Provider is listed, but none of the Netfinity
Manager-only systems are listed as shown in Figure 40. This is because
the Netfinity Director server does not automatically discover MPM clients.
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Figure 40. Netfinity Director console — only the server is discovered

3. Configure Netfinity Director to discover MPM clients. Click Options >
Discovery Preferences. Click the MPM Sites/Providers tab. Figure 41
appears.

Figure 41. Discovery Preferences panel

All of the available MPM Providers will be listed in the left column. These
are systems on which the MPM Provider has been installed. In our lab
environment, the system NFM_NTS4 is the only one listed.
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You’ll notice that in Figure 41, the MPM Provider starts with <LOCAL>.
Compare this with the equivalent window in Scenario 1, Figure 33 on page
67. <LOCAL> indicates that the MPM Provider is the system where the
console is running.

4. Select the MPM Provider and click the Add button to activate it.

The added providers then appear in the right column as shown in Figure
42:

Figure 42. Active MPM Providers

5. Click the MPM Systems tab. Here, you can specify how often you want
Netfinity Director to look for new Netfinity Manager systems. Figure 43
appears.

Figure 43. Setting the auto-discover period
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6. Specify the number of hours between discoveries. The auto-discover
function is disabled by default. We have set our auto-discover period to
occur every 24 hours.

If you also have auto discovery enabled in Netfinity Manager on the MPM
Provider, then the combination of both auto-discovery settings will ensure
that Netfinity Director can manage any new Netfinity Manager systems.

7. Click OK. This will initiate an MPM discovery on the selected MPM
Provider, which finds the other Netfinity Manager systems, as shown in
Figure 44.

Figure 44. Netfinity Manager systems manageable by Netfinity Director

Next to each MPM client is the text <<LOCAL>>. This indicates that the local
system is the MPM Provider that was used to detect each Netfinity
Manager system.

The following new entries appear in the console as shown in Figure 44:

a. Two new groups are created:

• IBM Netfinity(tm) Systems
• MPM Systems
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These groups are, in fact, identical in membership. MPM Systems is all
clients discovered by any MPM system. IBM Netfinity Systems is all
Netfinity Manager systems discovered via MPM. Since Netfinity
Director supports only Netfinity Manager-based MPM Providers, these
groups are the same.

b. The MPM clients are discovered.

These are the systems that were discovered by Netfinity Manager in
5.2, “Before you begin” on page 59.

These MPM systems can now be managed from Netfinity Director.

Notes:

• Netfinity Manager must be started before Netfinity Director starts. To do
this, either increase the value of the StartUpDelay registry key for Netfinity
Director, or add a DependOnService registry key to make TWGIPC
dependent upon NETFBASE.

• If you do not see the Netfinity Manager systems, ensure that Netfinity
Manager is running on the MPM Provider and that all systems have been
discovered in Netfinity Manager on that system.

• If the systems are listed more than once in the Group Contents panel, this
may be due to each client connecting to the server with more than one
network protocol (for example, NetBIOS and TCP/IP).

Now that the system is configured, you can manage these Netfinity Manager
systems from Netfinity Director as described below.

5.5 Managing MPM systems

Now that the MPM systems are discovered, they are managed in the same
way as Netfinity Director systems. MPM systems are valid targets for the
following Netfinity Director tasks:

• Send Netfinity Manager alerts to Netfinity Director

• Perform inventory collection

• View inventory

• View the event log

• Software distribution to Netfinity Manager clients

Software distribution is covered in 6.3, “Software distribution through MPM”
on page 112. The other tasks listed are covered in this section.
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Tasks that can be dragged and dropped onto the systems in the groups IBM
Netfinity Systems and MPM Systems are listed in the context menu when you
right-click a system name as shown in Figure 45:

Figure 45. Tasks available on Netfinity Manager MPM clients

Notes:

• The Presence Check entry in the context menu is incorrectly listed there.
This task is not supported with MPM clients.

• Software distribution is not available from the context menu. Refer to 6.3,
“Software distribution through MPM” on page 112 for instructions
regarding the use of the software distribution task.

The context
menu shows
the tasks
that can be
performed
on the MPM
clients.
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If you attempt a task that is not valid, you will see Figure 46:

Figure 46. Attempting to perform a task not supported

When managing MPM systems, you will notice the following differences when
compared to managing Netfinity Director clients:

• Individual MPM systems cannot be deleted from a dynamic group. The
MPM Provider can be de-activated by cli cking Discovery Preferences,
which will delete all MPM systems.

• Individual MPM systems cannot be added using the New function. Only
the MPM Provider can be activated, as opposed to individual systems.

• The amount of inventory data returned from MPM systems will be different
from the amount of inventory data returned from Netfinity Director
systems.

• When the MPM Provider is activated, it will automatically start forwarding
all of its alerts and events to Netfinity Director for processing. To control or
determine the cause of the alerts, refer to the documentation provided with
Netfinity Manager.

Note: Deleting the Netfinity Director system that is acting as the MPM
Provider will automatically delete all MPM systems discovered via the
provider.

5.5.1 Sending alerts to Netfinity Director

Alerts received by Netfinity Manager on the MPM Provider are automatically
forwarded to the event log of the Netfinity Director server. To send alerts from
all other Netfinity Manager systems, you must configure each of them to
forward all of their alerts to Netfinity Manager on the MPM Provider system.

When you install UMS on a system running Netfinity Manager (making it an
MPM Provider) as described in 5.3, “Scenario 1” on page 61 and 5.4,
“Scenario 2” on page 70, a new action Forward to MPM service is
automatically defined, as shown in Figure 47.
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Figure 47. New action Forward to MPM service

As you can see from Figure 48, this action forwards all alerts to Netfinity
Director:

Figure 48. Actions Forward to MPM service

In Netfinity Director, these alerts are, by default, saved to the server’s event
log.
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As an example, we configured a Process Manager alert in Netfinity Manager
on the system NFM_NTS4_2 to monitor the CALC.EXE process. When the
process stops, the alert will be forwarded to the Netfinity Director server log
as shown in Figure 49:

Figure 49. Event log showing the alert received from the Netfinity Manager client through the MPM Provider

If you want Netfinity Director to perform actions in addition to writing the alert
to the event log, then you must define an event action plan.

In the following steps, we configure an action plan which will pop up a window
on the console when certain alerts are issued from any of our Netfinity
Manager systems.

1. From the main console window, click the Event Builder icon .
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Figure 50. Creating a new MPM filter for MPM events

2. In the Event Filters panel, right click on Simple Event Filter and click
New.

3. Deselect the Any checkbox and then expand the MPM Provider for IBM
Netfinity branch. Figure 51 appears.

4. From the list select the specific events that you wish to receive from
Netfinity Manager to pass onto Netfinity Director. Use the Ctrl key to select
multiple events.
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Figure 51. Selecting specific MPM events

5. Adjust any other filter settings, or leave them as the defaults.

6. Click the Save button and enter a name for the filter.

Figure 52. Save the event filter

7. The new event filter now appears in the list:



84 Migrating from Netfinity Manager to Netfinity Director

Figure 53. MPM filter created

8. Next, define the action. In our example, the action is to display a pop-up
message on the console. Double-click Send an Event Message to a
Console User in the Actions panel. Figure 54 appears:

Figure 54. Creating the customized action
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9. Fill in the following information in the window:

– The text of the message to appear on the console. The text can include
variables; see online help for details and a list.

– The users that are to receive the message. Use * to send the message
to all administrators.

– Whether the administrators must be logged on at the time of the alert or
they receive the message the next time they log on.

10.Save the action. We named ours MPM pop-up, which now appears as an
action item under Send an Event Message to a Console User as shown in
Figure 55:

Figure 55. New action created

11.Next, create a new event action plan. Right click in the Event Action Plans
panel and click New > Event Action Plan.

12.Name the event action plan. We named ours MPM EAP. This then creates
a new icon in the Event Action Plans panel as shown in Figure 56:
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Figure 56. New Event Action Plan

13.The final step is to assign both the event filter and the action to the event
action plan:

� Drag the new filter, MPM filter, to the new event action plan, MPM EAP

� Drag the new action, MPM pop-up, to the filter icon that gets created in
step�.

These are shown in Figure 57:

Figure 57. Adding event filter and the action to the event action plan

14.Close the Event Action Plan Builder window.

15.Next, the event action plan is assigned to the MPM clients. Highlight each
of the MPM clients that you wish to have this event action plan applied to.
Use the Shift and Ctrl key to select multiple systems.

� �
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16.Drag the new event action plan, MPM EAP from Tasks onto one of the
highlighted systems.

Figure 58. Drag the event action plan onto the systems to activate it

17.You will then get the message:

Event action plan has been added to the selected group/system(s)

18.To verify that the event action plan was applied correctly, right click one of
the groups that contain the MPM clients (for example, All Systems and
Devices or MPM Systems) and click Event Action Plans. Figure 59
shows the event action plans associated with each system.
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Figure 59. Verifying the event action plan

That completes the setup to send alerts from Netfinity Manager systems
through the MPM Provider to Netfinity Director.

The next time a Netfinity Manager generates an alert for the specific
conditions that we chose, a pop-up message will appear on the Netfinity
Director console as shown in Figure 60:
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Figure 60. Pop-up message appears in Netfinity Director

For more detailed information about the alert, click the Event Details button:

Figure 61. More details about the event

5.5.2 Collecting inventory from Netfinity Manager clients

Hardware and software inventory information for Netfinity Manager (MPM
systems) is available to the Netfinity Director server via the MPM Provider
once Netfinity Director has discovered the MPM systems.

To gather inventory data from systems:

1. From the Group Contents panel in the console, select one or more
systems. Use the Ctrl and Shift keys to select multiple systems.
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2. Right click one of the selected systems, and click Perform Inventory
Collection.

Figure 62. Select the MPM systems you wish to perform inventory on

A status window appears with the message Collection in progress for each
system. Once the inventory is succesfully gathered, the status will change to
Collection completed successfully.

Note: If the status immediately changes to No Inventory Data Returned, run
the Netfinity Provider Configuration program (NFPRVCFG.EXE) on the MPM
Provider system and verify that both software and hardware inventory is
enabled. (see Figure 30 on page 63 or Figure 39 on page 73 depending on
whether you used scenario 1 or scenario 2). See the online help for other
status messages.

Once the inventory collection has completed successfully, the inventory
information can be viewed by dragging the Inventory task onto the systems
you wish to view.
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Figure 63. Viewing the inventory of selected systems

This then starts the Inventory Query Browser window, where you can view the
data about each system.

Figure 64. The Inventory Query Browser



92 Migrating from Netfinity Manager to Netfinity Director

5.5.3 Software distribution to Netfinity Manager systems

Software distribution to an MPM-managed system is only possible using the
streaming methods. Redirected distribution via a distribution server is not
supported with Netfinity Director (IT Director does support this however). This
means that the software package is copied directly from the Netfinity Director
server to all MPM-managed systems.

During streamed distribution, software packages from Netfinity Director
server are first copied to each destination agent machine. After that, the agent
initiates the local installation process.

Netfinity Director has a limited ability to perform software distribution. You can
install only preconfigured software packages. Currently, you can install only
the following products using Netfinity Director software distribution:

• UMS client
• UM Server Extensions

The procedure is described in 6.3, “Software distribution through MPM” on
page 112.
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Chapter 6. Installing UMS on clients

As described in 2.1, “Components” on page 3, Universal Manageability
Services (UMS) is the Netfinity Director client. This chapter shows how to
install UMS on clients. We explain the installation process using two
methods:

• Manual install using the graphical user interface
• Unattended install

We cover the installation of UMS on Windows, OS/2, and NetWare systems.
We discuss the different choices and explain the prerequisites for the clients.

Note: There is no unattended installation option for NetWare clients. We will
not cover the installation of the SCO client. It is not a part of the upgrade
path. For more information of how to install the SCO client see the
readme.unix file located at \win32\install\en\readme.unix.

The hardware and software prerequisites are listed in 3.4, “Supported
systems” on page 37.

6.1 Installing UMS

The UM Services client is a software program that needs to run on every
system to be managed by the Netfinity Director server (from a Netfinity
Director console) or from a Web browser. In this section, we describe how to
install the Windows, OS/2 and NetWare clients via the standard user
interface. We also discuss unattended installation in 6.2, “Unattended
installation of UMS” on page 105.

Note: The installation of UMS is the same, regardless of whether the system
is a client workstation (such as an IBM PC 300PL) or a Netfinity server. The
differences are in the separately installed extensions such as the Netfinity
server extensions, not in the base UMS code itself. For more information
about UM Server Extensions see 6.4, “Installing UM Server Extensions” on
page 117.

6.1.1 Manually installing the Windows client

This section describes the UMS installation on:

• Windows 95 (with OEM Service Release 2 or later)
• Windows 98
• Windows NT (Workstation or Server, SP 4 or later)
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• Windows 2000 (Professional, Server, or Advanced Server)

The UMS installation begins the same way as the server and console began
as described in Chapter 4, “Installing Netfinity Director server and console”
on page 45. Depending on how you obtained the UMS client code, either you
simply insert the CD-ROM and let the install program start automatically or
you run x:\win32\install\ibmsetup.exe (where x is your CD-ROM drive).

A welcome window appears. Click Next to continue, then the software license
agreement will appear. Click Accept to bring up Figure 65.

Figure 65. Click Client to install the UMS client

As we are installing the UMS client, click Client to continue your installation.
For information regarding the other options refer to Chapter 4, “Installing
Netfinity Director server and console” on page 45.

Figure 66 appears.

You must be logged on to the client with local administrator or equivalent
rights.

Note
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Figure 66. UMS client configuration

Click the checkbox next to each components in Figure 66 that you want to
install on the client system. These are as follows:

• Basic Services (selected by default)

Basic Services installs the Java Virtual Machine, Common Information
Model (CIM) repository, Desktop Management Interface (DMI) 2.0
compliant service provider, and basic instrumentation for gathering
hardware inventory data.

The inventory information provided by Basic Services can be viewed
through a CIM browser such as Microsoft WBEMTEST. The IBM managed
information format (MIF) generator program (CIM2MIF) can also be used
to generate inventory files that can be exported to system-management
applications, such as Tivoli Enterprise. Microsoft SMS, or CA Unicenter
TNG Framework. Basic Services must be installed on all UMS clients.

You cannot deselect this component.

• Netfinity Director Support (selected by default)

Installs the support to be able to manage the agent with the Netfinity
Director server. This component is required since we are using Netfinity
Director.

Note: This option appears only where you are installing the client. When
you install the Netfinity Director server, the option does not appear.
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• Web Based Access (selected by default)

Web Based Access offers a convenient Java-based tool for managing a
client system and for viewing the CIM-based inventory data. With Web
Based Access installed on the client system, the client can be managed
from any remote computer with a supported Web browser. No software
other than a Web browser is needed on the remote system.

If you install Web Based Access, an HTTP daemon is installed and
requires a user name and password be entered during the installation.
The user name and password is used to limit access to the HTTP daemon.

• System Health Monitoring (selected by default)

System Health Monitoring provides active monitoring of critical system
functions such as:

– Disk space available
– System temperature
– Fan functionality
– Power supply voltage
– System cover removal

System Health Monitoring lets you detect system problems early, before
system failures occur. System administrators are notified of a system
problem by a CIM event, SNMP trap, or SMS Status Message (Microsoft
SMS 2.0 only). SNMP traps are available only if SNMP access and trap
forwarding is also selected.

Critical problems also result in a pop-up message appearing on the
display of the client system.

Note: Only specific systems fully support this feature. These systems
currently are IBM PC 300GL, 300PL, Intellistation, Netfinity 1000, Nefinity
3000, and Netfinity 3500.

• Web Based Remote Control

This component lets a systems administrator on a remote system take
control of the client desktop using a Web browser or the Microsoft
Management Console (MMC).

You must also install the Web Based Access component if you install the
Web Based Remote Control component.

Note: You should not enable both Web-based remote control (Figure 66 on
page 95) and Netfinity Director-based remote control (Figure 70 on page
99). If you do, you may receive a trap screen (blue screen of death) on the
target system.
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• LANDesk Management Suite Integration

LANDesk Management Suite Integration installs the Intel Common Base
Agent on the client system. This enables the systems administrator to use
UMS with LANDesk Management Suite.

Select this component is you want to manage this client using LANDesk.

• Tivoli Management Agent

Tivoli Management Agent installs support on the client system that
enables it to be managed by the Tivoli Enterprise systems-management
platform.

Select this component is you want to manage this client using Tivoli.

• SNMP access and trap forwarding

This feature enables CIM information to be accessed from a system using
the Simple Network Management Protocol (SNMP). If System Health
Monitoring is enabled, this option also enables System Health to forward
CIM events as SNMP traps.

This component requires that you have the SNMP service (provided with
the operating system) installed on the client. If the SNMP service is not
installed, the system prompts you to insert the operating system
installation media and install SNMP during the UMS installation.

• DMI Support

Desktop Management Interface (DMI) is a standard that is the result of the
work of the Distributed Management Task Force. DMI is code that is
implemented in your system’s BIOS and in the operating system. It acts as
a layer of abstraction between the management software and the system’s
components.

By selecting this component, you are installing support for DMI to be able
to manage and inventory DMI-compliant components in your system. The
DMI interface generates a standard framework for managing and tracking
components in a desktop PC, notebook, or server. When this component
is selected, you will be asked what type of system you are installing on as
shown in Figure 67 on page 98.

Click Next to continue with your installation.

Select the directory where you want the client code installed. We recommend
you choose the default. Click Next to continue the installation.
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Note: Depending on the selections you make you will see different
installation windows at this point. Figure 67 appears because we select DMI
Support in Figure 66 on page 95:

Figure 67. Select the type of client

This window prompts you to specify what type of system this is. It is used by
the DMI support to determine which DMI components should be installed.

Figure 68. Install SNMP on the client

To start the operating systems installation wizard for adding SNMP support
click Yes. For a guided tour through the SNMP installation see 1.4.4 “SNMP’s
role” in Netfinity Director Integration and Tools, SG24-5389.
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Figure 69. Add icons for UMS to the client’s start menu

Click Yes if you want to add icons for UMS to the client’s start menu.

Figure 70. Netfinity Director Remote Control installation option

Clicking Yes will enable this client to be remotely controlled from a Netfinity
Director console. Based on the selections that we made in Figure 66 on page
95 it is the only way to remotely control the client, so we clicked Yes.

Note: You should not enable both Web-based remote control (Figure 66 on
page 95) and Netfinity Director-based remote control (Figure 70). If you do,
you may receive a trap screen (blue screen of death) on the target system.

Figure 71. User authorization for remote control

If you are installing the UMS client on a Netfinity server, then you probably
should select No to this question. A server is usually locked away so there
will be no one to authorize your request. On the other hand if you are
installing a client on which there is an active user you want to select Yes so
that the user will have to authorize you to access his or her computer.

Reboot the system when prompted.
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After the reboot, if you plan to install UM Server Extensions, follow the
instructions in 6.4, “Installing UM Server Extensions” on page 117.

As with Netfinity Manager, you can use the Network Driver Configuration
window to configure the system name and protocols that are enabled to
communicate from the client to the Netfinity Director server. During
installation, however, you are not prompted to set these values; they are set
automatically.

To change them once installation is compete, run TWGIPCCF from a command
line (the directory where it is installed, C:\Program Files\IBM\Director\bin, is
in the path statement). Figure 72 appears:

Figure 72. Network Driver Configuration for the client

All network protocols are enabled by default. Once you’re finished making
changes, reboot the system.

6.1.2 Manually installing OS/2 clients

To start the OS/2 installation of UMS run the setup.cmd in x:\os2, where x: is
the drive letter of the CD-ROM drive or the installation point on the network.
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Figure 73. UMS installation on OS/2

Choose the directory to install from and where to put the code.

Figure 74. Options to install

Choose which options you want to install:

• Netfinity Provider

This component gives you the ability to let the client act as a gateway to
Netfinity Manager systems. That means that you can manage your old
Netfinity Manager systems through the Netfinity Director console. You
must have Netfinity Manager installed on the system before this option
can be selected. The Netfinity Provider is also known as the MPM
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Provider and is discussed in detail in Chapter 5, “Coexistence using MPM”
on page 57.

• Remote Control Agent

This component gives you the capability to remotely control the keyboard
and mouse from the Netfinity Director console and performs the same
function as Remote Workstation Control in Netfinity Manager. We installed
the Remote Control Agent to be able to manage this client from our
Netfinity Director consoles.

Click Install to continue.

Figure 75. Network Driver Configuration

Figure 75 lets you configure your network settings. Enable the network
drivers you want to use and select the timeout value.

• Require User Authorization for Screen Access

If you are installing the client on a Netfinity server, then you would
probably leave this setting unchecked. A server is usually locked away
and there will be no one to authorize your request. On the other hand if
you are installing a client on which there is an active user you may want to
check the option so that the user will have to authorize you to access his
or her computer.



Chapter 6. Installing UMS on clients 103

• Enable Wake on LAN

Wake on LAN (WOL) is a remote wake-up technology that enables you to
remotely power systems on. It is a result of the Intel-IBM Advanced
Manageability Alliance. To be able to use this function your hardware must
support it. The components that are needed to support WOL are the
motherboard, network adapter, and the system’s BIOS. If you have a system
that is capable of Wake on LAN you may want to check the Enable Wake-On-
LAN check box. This will enable the system to be powered on remotely. Click
OK to continue.

Figure 76. Driver configuration saved

The driver configuration is saved.

Click OK to continue the installation. The installation prompts you that it
needs to update your CONFIG.SYS.
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Figure 77. Change CONFIG.SYS

Select Yes if you want to automatically add the lines in your CONFIG.SYS.
Select No to manually add them. We clicked Yes.

Figure 78. Installation complete

Click OK to finish your installation. Reboot to complete and activate the UMS
client.

6.1.3 Manually installing NetWare clients

Before you begin installing the NetWare client, you must remove Netfinity
Manager Client Services. The Netfinity Manager and Netfinity Director clients
cannot coexist on the same NetWare system due to common module names.
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To uninstall Netfinity Manager Client Services, unload the Netfinity module
and remove the following lines from AUTOEXEC.NCF:

SEARCH ADD sys:netfin
LOAD netfbase

For instructions on how to install the NetWare client, see 2.4 “NetWare V5.0
agents” in Netfinity Director Integration and Tools, SG24-5389. One exception
to these instructions is that the installation is started with the following
command:

..\WIN32\INSTALL\files\NfD\AGENT\NOVW32\TWGSETUP.EXE

Note: The UMS client does not run on a Novell NetWare 4.11 SFT III system.

6.2 Unattended installation of UMS

This section describes how to install UMS remotely without the use of the
client user interface.

6.2.1 Unattended installations on Windows

The UMS installation wizard uses InstallShield as the installation engine. As
well as providing a GUI to the installation routine, InstallShield is also capable
of unattended installations using response files. This section introduces this
capability. If you are already familiar with InstallShield from other product
installations, then this process will be straightforward.

For more information and troubleshooting see:

http://www.installshield.com

The UMS installation is based on the response file
WIN32\INSTALL\EN\SETUP.ISS in the installation CD-ROM. You can copy
and modify this file to suit your installation requirements.

The file contains the following:

[InstallShield Silent]
Version=v3.00.000
File=Response File

[Application]
Name=UMS
Version=2.0
Company=IBM

[DlgOrder]
Dlg0=SdAskOptions-0

http://www.installshield.com
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Dlg1=AskDestPath-0
Dlg2=AskSecurInfo-0
Count=3

[SdOptionsButtons-0]
Result=103

[SdOptionsButtons-1]
Result=101

;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;              USER CONFIGURABLE SECTION                    ;
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;UMS detected on system. Would you like to upgrade? Yes or No
;Available options:
; 1 = Yes
; 0 = No
[UpgradeYesNo]
Result=0

;The following is a list of available options. If adding options in the section below, 
;Component-count must be accurately indicated, and all options must be sequentially 
numbered,
;starting at zero. Available options: (note: Basic Services cannot be removed as an 
option) 
;Component-x=Basic Services
;Component-x=Netfinity Director Support
;Component-x=Web Based Access
;Component-x=System Health Monitoring
;Component-x=Web Based Remote Control
;Component-x=LANDesk(TM) Management Suite Integration
;Component-x=Tivoli Management Agent
;Component-x=SNMP access and trap forwarding
;Component-x=DMI Support
;Add components below if desired. Recommended defaults are already set below.
[SdAskOptions-0]
Component-type=string
Component-count=4
Component-0=Basic Services
Component-1=Web Based Access
Component-2=System Health Monitoring
Component-3=SNMP access and trap forwarding
Result=1

;installation directory
[AskDestPath-0]
szPath="C:\Program Files\IBM\UMS"
Result=1

;username and password for web access
[AskSecurInfo-0]
svUser=ums
svPassword=ums
svConfirm=ums
svPort=411
Result=1

;DMI machine type
; Options: Server
; Mobile
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; Desktop
[DMI]
DMIType=Desktop

;Do you want icons on the start menu?
[Icons]
Result=0

;If you installed Netfinity Director support, Would you like NfD Remote Control?
[NfDRemote]
Result=1

;Auto Reboot machine when install is finished?
[AutoReboot]
Result=0

The InstallShield software supports recording your own response files by
running the standard UMS installation program with some command-line
parameters and making all selections you want during the installation
process.

Note: The process of recording the installation actions to a response file
actually performs a real installation of the product, based on your selections.

Run the following from a command prompt:

SETUP -R -F1[ISS-file] -F2[LOG-file]

where:

• SETUP is the executable installation file.

• -R specifies run setup in record mode

• [ISS-file] is the full path and name where you want to save the response
file.

• [LOG-file] (if specified) is the log file where additional debug information
is recorded. This is useful if you encounter problems.

Notes:

• Case is not important.

• The default file name for the response file is SETUP.ISS.

• The default directory for SETUP.ISS is in the same as the SETUP.EXE file.

• There is no space between -f1 and the path for example
-f1x:\responsefiles\setup.iis

• When you create the ISS file, you should use a system that is similar to
the clients in your network (operating system, drive letters, and so on).
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When you run the setup program with these parameters, you will see the
same dialogs that you see in an attended setup. Based on the selections you
make, a response file is created. If you want to do the same installation as
shown in 6.1.1, “Manually installing the Windows client” on page 93 just follow
the instructions listed there. The resulting response file will look like the
following:

[InstallShield Silent]
Version=v3.00.000
File=Response File
[Application]
Name=UMS
Version=2.12
Company=IBM
[DlgOrder]
Dlg0=SdWelcome-0
Count=11
Dlg1=SdOptionsButtons-0
Dlg2=SdAskOptions-0
Dlg3=AskDestPath-0
Dlg4=AskOptions-0
Dlg5=AskYesNo-0
Dlg6=AskYesNo-1
Dlg7=AskYesNo-2
Dlg8=AskYesNo-3
Dlg9=SdFinishReboot-0
Dlg10=MessageBox-0
[Squelches-0]
Result=1
[SdOptionsButtons-0]
Result=103
[SdAskOptions-0]
Component-type=string
Component-count=5
Component-0=Basic Services
Component-1=Net&finity Director Support
Component-2=System Health &Monitoring
Component-3=&SNMP access and trap forwarding
Component-4=&DMI Support
Result=1
[AskDestPath-0]
szPath=C:\Program Files\IBM\UMS
Result=1
[AskOptions-0]
Result=1
Sel-0=0
Sel-1=1
Sel-2=0
[AskYesNo-0]
Result=0
[AskYesNo-1]
Result=1
[AskYesNo-2]
Result=1
[AskYesNo-3]
Result=1
[SdFinishReboot-0]
Result=1
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BootOption=0
[MessageBox-0]
Result=1

Once you have the response file ready, you can repeat the installation on
another system in unattended or silent mode, with the following command:

SETUP -SMS -S -F1[ISS-file] -F2[LOG-file]

• The SMS parameter must be uppercase. The other parameters are not
case sensitive.

• -S specifies to run the installation in silent mode.

• -SMS prevents a network connection and the SETUP.EXE from closing
before the installation is complete. This switch works with installations
originating from a Windows NT server over a network.

• -F1 specifies the path to the response file.

• -F2 specifies the full path to put a log file.

Notes:

• If you run setup without specifying the -F1 parameter, setup will look for
the file SETUP.ISS in the same directory as SETUP.EXE.

• With the -F1 variable you can have many response files covering all your
different client types and configurations.

6.2.2 Unattended installations on OS/2

The install engine for unattended installations of the OS/2 client works with
*.RSP files. An RSP file is a file that answers the same questions that you do
in a manual installation. The response files for the unattended installation for
OS/2 are included in the OS/2 language subdirectory. For example, the
sample English language response file, DIRAGENT.RSP, is located in the
WIN32\INSTALL\FILES\NFD\AGENT\OS2\EN\ directory on the CD-ROM.
Comments within the response files begin with a semicolon in the first
column. All entries can be changed. When you have completed the
configurations in the DIRAGENT.RSP file, launch the unattended installation
of the OS/2 agent by running the following from a command prompt:

install.exe /R:filename 

Where filename is the fully qualified response file.



110 Migrating from Netfinity Manager to Netfinity Director

6.2.3 Getting the code to the clients

Once you have prepared your unattended installation, the next step is to
make the code available to the clients so that you can run the SETUP or
INSTALL program unattended. In this section, we introduce some of the ways
to do this.

Note: You must be logged on to the client with local administrator or
equivalent rights.

6.2.3.1 System image

If you want to roll out a client image containing UMS using tools such as
Ghost or DriveCopy, you must first do the following before creating the source
image:

• Remove the TWGMACH.ID file from the C:\Program
Files\IBM\UMS\Director\Data directory.

• Remove the value for the TWGMachineID key in the registry.

6.2.3.2 Login script

The login script lets you run a program when the user logs on to the system.
To be able to use this option, you need good knowledge about the login script
language you choose. There are a lot of different script languages that can be
used, especially in a Windows NT environment. These are some of the most
common:

• Batch files

These are ordinary batch files that you set up on your server. For more
information about batch files and login scripts in the NT environment ,see
the Windows NT Server System Guide on Microsoft’s Web site at
http://www.microsoft.com, through Microsoft TechNet or your MS-DOS
documentation.

• OS/2 REXX

OS/2 supports REXX-based logon scripts by default. Refer to the OS/2
REXX Command Reference for details.

• Perl

Perl is supported by most platforms, including OS/2 and Windows. This
support, however, is not enabled by default. A Perl interpreter must be
installed before Perl scripts can be used.

http://www.microsoft.com
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• KIXTART or KIX32

KIXTART is a logon script processor and/or enhanced batch language for
Windows NT and Windows 9x workstations in a Windows networking
environment. It is very powerful and can be used to do many things that
you cannot do with ordinary batch files. To get the latest version and more
information use your favorite search engine and search for KIXTART on
the Web.

• NetWare login scripts

NetWare supports a lot of variables and functions, for a detailed list on the
commands see “Login Script Commands and Variables” in Chapter 3 of
Supervising the Network or visit http://support.novell.com and search
for login scripts to get hints and tips on how to configure your scripts.

For Windows NT and Windows 2000, the use of logon scripts to install UMS
requires that the users be local administrators.

To be able to install UMS through the login script, you would need all your
clients and computers to be connected to the network. They must be
organized so that when the users login they will run some kind of centralized
login script that includes the installation command as described in 6.2,
“Unattended installation of UMS” on page 105.

As part of your login script, you may also want to consider:

• Adding a version checker. This means that the installation process won’t
need to run every time your clients log in. For example, it could work like
this:

a. Copy a file with the installation package named after the version.
b. In your login script check for the file and if you find it skip the

installation program.

• Load balancing, so that installation can take place from different servers
on different subnets. This is especially important if you have a lot of WAN
connections. In this scenario you will need a network chart. The easiest
way to do this is if you have a naming convention of your computers that
tells where they are located. If you do not have that, you will need to use
the IP addresses to sort out the different computers. For more information

Be careful when you modify or add script files to your domain as this will
affect everyone using the login script.

Note

http://support.novell.com
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about this, visit http://www.microsoft.com or use Microsoft TechNet to
help you decide which way is best for your environment.

• Adding a routine to the script in multiplatform configurations, so the correct
operating system-specific version of UMS is installed. If you have a
Windows environment you can do that with the VER command from a login
script. For more information about this visit http://www.microsoft.com or
use Microsoft TechNet.

6.2.3.3 Netfinity Manager: file transfer and batch file

This way depends on whether you are able to get the files out to the client
and then execute a file locally on the system.

One way of doing this is to use Netfinity Manager’s scheduler to distribute the
files using the file transfer feature and then use the remote session feature to
start the unattended installation.

6.2.3.4 Using MPM

This method uses the MPM Provider configuration you set up in Chapter 5,
“Coexistence using MPM” on page 57 to install the UMS and UM Server
Extensions code on the clients. See the following section for details.

6.3 Software distribution through MPM

Netfinity Director has a limited ability to perform software distribution. You can
only install pre-configured software packages. Currently, you can install only
the following products using Netfinity Director software distribution:

• UMS client
• UM Server Extensions

There are three main limitations:

• You must go through an MPM Provider, which means that the client must
be accessible from Netfinity Director via MPM. See Chapter 5,
“Coexistence using MPM” on page 57 for details about MPM.

• Since MPM is required, each client will need one client license from
Netfinity Director. For more information about licensing, see 3.5.1, “MPM
licensing” on page 43.

• Only Windows 95/98 and Windows NT are supported.

http://www.microsoft.com
http://www.microsoft.com
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Notes:

• In Netfinity Director, MPM works only with Netfinity Manager clients. With
IT Director, you can also distribute to SMS and Intel LANDesk clients.

• On Windows 95/98 systems running Netfinity Manager 5.1 or earlier, there
is a problem with remote execution of the software distribution function. To
solve this, copy the file RCSHD.EXE from the Netfinity Manager 5.20.X
CD-ROM to the WNETFIN directory.

The procedure to install UMS via Netfinity Director’s software distribution is
as follows:

Figure 79. Software distribution through MPM

1. The first step is to import the predefined package available to Netfinity
Director. From the Netfinity Director console, shown in Figure 79, right
click Software Distribution under Tasks and click Open to open the
Software Distribution Manager. Figure 80 on page 114 appears.
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Figure 80. Package selection

2. Double-click IT Director File Package to get to the browser menu in
Figure 81.

Figure 81. Import IT Director Package

3. Browse to the file package you want to import.
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4. Click Next to continue. Verify that the correct package has been selected
as per Figure 82.

Figure 82. Netfinity Director file package

5. Click Finish to complete the import process. You should then see
something similar to Figure 83 showing the file package that was
imported.

The latest UMS and UM Server Extensions file packages are not
included on the Netfinity Director CD. However, they should be available
on ServerGuide and from the following Web site:

http://www.pc.ibm.com/ww/software/applications/ums/download.html

Latest packages

http://www.pc.ibm.com/ww/software/applications/ums/download.html
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Figure 83. Software distribution package ready for distribution

To install the package on an MPM client, simply drag and drop the package
onto an MPM system. The package will then be installed on the client without
further user interaction (that is, an unattended installation).

Notes:

• You cannot create your own file packages for distribution with Netfinity
Director. You can, however, do this with IT Director. Refer to Chapter 9,
“Upgrading to IT Director” on page 165 for more information.

• The file packages that will be available from the Web are standard
installations. It is not possible to modify any settings in the package. To be
able to change or build your own packages you will need to upgrade to IT
Director.

• The distribution in Netfinity Director supports only streaming mode
distribution. This means that every package is distributed directly from the
Netfinity Director server. This is not recommended if you have systems in
a WAN environment, because you will probably impact network
performance.
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6.4 Installing UM Server Extensions

As described in 2.1.4, “UM Server Extensions” on page 6, UM Server
Extensions is a set of tools to extend the manageability of IBM Netfinity
servers (that is, the Netfinity-branded PC servers). There are three
components to UM Server Extensions and each component is installed
depending on which components of Netfinity Director or IT Director are
installed:

• Server component: installs on the system running the Netfinity Director
server (or IT Director server)

• Console component: installs on the systems running the Netfinity Director
console (or IT Director console)

• Client component: installs on the systems running UMS. You only need to
install UM Server Extensions on Netfinity servers running. Installing UM
Server Extensions on other types of clients (such as ThinkPads,
Intellistations or PCs) will work, but does not install any additional function
on those systems.

For example, because the Netfinity Director server has the server, console,
and UMS products installed, all three UM Server Extensions components will
be installed as well.

Before you begin installing UM Server Extensions, you must have the
appropriate Netfinity Director component(s) already installed.

See the UM Server Extensions User’s Guide for more information about the
product. It is available from:

ftp://ftp.pc.ibm.com/pub/special/sysmgmt/UMSRVEXT.pdf

To install UM Server Extensions, do the following:

1. Run Setup from the UM Server Extensions directory on the CD.

UM Server Extensions is only supported on IT Director systems when IT
Directory is upgraded from Netfinity Director (that is, Netfinity Director and
UM Server Extensions are installed and Netfinity Director is subsequently
upgraded to IT Director).

UM Server Extensions is not supported when IT Director is installed from
scratch without Netfinity Director being installed first.

IT Director support

ftp://ftp.pc.ibm.com/pub/special/sysmgmt/UMSRVEXT.pdf
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2. Click Next to get the welcome window and click Next. You will then see all
the tools that will be installed on your system. There are no options you
can change.

3. Click Next. If Netfinity Director is still running on the server you will be
prompted to shut it down.

4. Click Yes to continue the installation. Once the installation says it is
finished, click OK.

Notes:

• The UMS service will automatically start up again.

• The server does not need to be rebooted, unless you are running
Windows 2000.

6.4.1 Unattended installation of UM Server Extensions

The UM Server Extensions uses InstallShield and works the same way as an
unattended installation of UMS, as described in 6.2, “Unattended installation
of UMS” on page 105.

To create the setup.iss file, execute the following command:

x:\setup.exe -r -f1x:\setup.iss

It will create the following file:

[InstallShield Silent]
Version=v3.00.000
File=Response File
[Application]
Name=IBM Netfinity Director Extension Installer
Version=CurrentVersion
Company=IBM
[DlgOrder]
Dlg0=SdBitmap-0
Count=5
Dlg1=SdWelcome-0
Dlg2=SdStartCopy-0
Dlg3=AskYesNo-0
Dlg4=MessageBox-0
[SdBitmap-0]
Result=1
[SdWelcome-0]
Result=1
[SdStartCopy-0]
Result=1
[AskYesNo-0]
Result=1
[MessageBox-0]
Result=1
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To install a client unattended, execute the following command:

x:\setup.exe -s -SMS -f1x:\setup.iss

For information about these parameters, see 6.2.1, “Unattended installations
on Windows” on page 105.

Note: You do not have to reboot the server after installing UM Server
Extensions.
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Chapter 7. Recreating configuration data

At this point in your migration, you have installed Netfinity Director on many of
your systems and the environment is working properly. The next step is to
bring all your Netfinity Manager configuration settings into Netfinity Director.

Unfortunately, there is no simple, automatic procedure to convert from
Netfinity Manager to Netfinity Director. There are no tools currently available
that help us convert data from Netfinity Manager to Netfinity Director. Instead,
you will have to find all the configuration settings you’ve made in Netfinity
Manager and reenter those into Netfinity Director.

This chapter shows you the important values and settings and gives you
some hints and tips on how to insert the data from Netfinity Manager into your
Netfinity Director environment. We provide some worksheets to aid in the
gathering of your data.

We will focus on those parts in Netfinity Manager that contains data that can
be moved from Netfinity Manager to Netfinity Director.

• Alert Manager
• Security Manager
• System Monitor
• Event Scheduler
• Remote System Manager
• Process Manager
• Advanced System Manager

Notes:

• Not all data in Netfinity Manager can be transferred to Netfinity Director. In
the tables in this chapter, we show the data that is usable in Netfinity
Director. Some functions may be named differently in Netfinity Director.
For more information about the functions see 2.3, “Netfinity Director
functions” on page 14 and particularly Table 1 on page 15.

• In Netfinity Manager you can use the Critical File Monitor to monitor
changes to specific files. In Netfinity Director, there is no similar function.

A set of blank worksheets as described in this chapter is available in
Appendix A, “Worksheets” on page 179.

Blank worksheets
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7.1 Alert Manager

In Alert Manager, user settings are configured in the Actions and Profiles
functions. These functions are accessible via buttons in Alert Manager, as
shown in Figure 84:

Figure 84. Alert Manager in Netfinity Manager

The list of actions that you’ve defined can be obtained by clicking the Actions
button. Figure 85 appears:
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Figure 85. Alert Actions in Netfinity Manager

The list of profiles that have been defined can be obtained by clicking the
Profiles button. Figure 86 appears:

Figure 86. Alert Profiles in Netfinity Manager

You should go through the actions and profiles listed and write down the
properties for all of them that you wish to use in Netfinity Director. Highlight
each action or profile, and click Edit to view the configuration of that action or
profile. You’ll see something like Figure 87:
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Figure 87. Action Editor in Netfinity Manager

Use Table 7 as a guide to what you need to write down. Blank worksheets can
also be found in Appendix A, “Worksheets” on page 179.

Table 7. Alert conditions

Action Alert types Severity Source
applications

Sender ID

Example: Notify user with pop-up Any 0,1,2,3 Any Any
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The data from Table 7 should be inserted in the Event Action Plan Builder in
Netfinity Director. The Event Action Plan Builder manages all of the alerts in
Netfinity Director as shown in Figure 88.

For more information on how to use and configure the Event Action Plan
Builder, see 6.2.3 “Event Action Plans” in the redbook Netfinity Director
Integration and Tools, SG24-5389.

To open the Event Action Plan Builder, click the Event Builder icon from
the main console window.

Figure 88. Event Action Plan Builder in Netfinity Director

Note: Most actions cannot be performed on the UMS client. The exceptions
are to start a program or to start a Netfinity Director task at the client. All
other actions must occur either at the console or at the server.

You can have multiple actions and filters in the one event action plan. As a
result, you can either create a new event action plan or you can add events to
an existing event action plan.
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To create the action shown in Figure 87 on page 124 in Netfinity Director, do
the following from the Netfinity Director console:

1. Create an event action plan or use one that you have created before. To
create a new event action plan, right-click in the Event Actions Plans panel
in Figure 88 and click New > Event Action Plans. Figure 89 appears.

Figure 89. Create Event Action Plan in Netfinity Director

2. Enter the name of the event action plan. We named ours “Severity
0,1,2,3”.

3. Right-click in the Event Filters panel and click New > Event Filter. Figure
90 appears. From here you can select which monitor type you are
interested in. In our example we are just interested in the severity.

Figure 90. New event filter in Netfinity Director
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4. Click the Severity tab and specify the severities listed in Table 7 on page
124 as shown in Figure 91. Use the following as a guide to convert
Netfinity Manager severity levels to Netfinity Director levels:

0 Fatal
1 Critical
2 Minor
3 Warning
4-7 Harmless

Note: In Netfinity Director, there is a severity Unknown. There is no
equivalent in Netfinity Manager. Unknown is used when the application
generating the event does not assign a severity level to the alert.

Figure 91. Severities in Netfinity Director

5. Save the filter by clicking . When prompted, name your filter. We named
ours “Severity Fatal and Critical”. Close the window.

6. Create an action by double-clicking one of the actions in the Actions panel
in Figure 88 on page 125. We double-clicked on Send an Event Message
to a Console User. Figure 92 appears.

Since we cannot pop up a window on the client in Netfinity Director, we will
display the pop-up message at the console instead, as shown in Figure
92:
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Figure 92. Customize action in Netfinity Director

7. In the Message field, you can put whatever text you want. There are also a
number of predefined variables that you can use. See the online help for a
full list. In this example we used:

– &severity — the severity of the alert
– &system — the name of the system where the alert occurred

Two other commonly used variables are &date and &time. They put a date
and time when the action occurred.

8. Save the action by clicking . When prompted, name the action. We
named ours “Severity notify”.

9. Close the window.

10.Apply the new filter and new action as follows:

a. Drag the newly created event filter “Severity Fatal and Critical” from the
Event Filters panel to the Event Action Plans panel, shown as � in
Figure 93.

b. Drag the newly created action “Severity notify” from the Actions panel
to the Event Action Plans panel, shown as � in Figure 93.
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Figure 93. Event Action Plan Builder in Netfinity Director

Note: You must perform these two steps in the correct order.

11.Close the Event Action Plan Builder window. The main console window
appears as shown in Figure 94.

�

�
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Figure 94. Applying an event action plan to a system

12.Activate the event action plan by dragging it from the Tasks panel to the
system that you want to use the event action plan on as shown in Figure
94.

The action is now enabled in Netfinity Director.

Note: As we describe in 9.1.5, “Advanced group management” on page 173
there is no support to drop the event action plan to a group of systems in
Netfinity Director. You can, however, select multiple systems using the Shift or
Ctrl keys in conjunction with a mouse click, and drag the event action plan to
one of the selected systems.

For more information on how to use and configure the Event Action Plan
Builder, see 6.2.3 “Event Action Plans” of the redbook Netfinity Director
Integration and Tools, SG24-5389.

7.2 Security Manager

In Netfinity Manager the security is handled separately by each of the clients.
It is called Peer to Peer security system. That means that the security is

Drag the event
action plan onto
the system to
active it.
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provided locally on each system. In Security Manager, we need to write down
the configured users and what they are allowed to do. Figure 95 shows a user
that is configured in Netfinity Manager.

Figure 95. Security Manager in Netfinity Manager

Enter the configuration information in Netfinity Manager into Table 8:

Table 8. Security Manager configuration data

User ID Services Security
Manager

Example: JOHAN Alert, AOL, CFM, DCM, Scheduler, POED, Process, Remote Session,
RWC, Inventory, SI, SysMon, Profile

No
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As described in 2.2.2, “Security” on page 10, Netfinity Director uses a
centralized security model, storing all security access information on the
Netfinity Director server and users can be defined in two ways:

• Create the user using Console Security in Netfinity Director. You can use
this option if you want a group of administrators to access Netfinity
Director all with the same userid and password. These are known as
non-native user accounts.

• Create the user using Windows NT/2000’s User Manager on the Netfinity
Director server. The user’s ID and password are controlled through the
operating system’s security functions. This means that Netfinity Director
administrators need to remember only their Windows password. These are
known as native user accounts.

See 2.2.2, “Security” on page 10 for details on how Windows user groups
are used to gain access to Netfinity Director.

Once the user is defined, the Console Security task is used to restrict access
to specific groups and tasks. Click Options > Console Security, which
displays a window similar to Figure 96:

Figure 96. Console Security in Netfinity Director

This will show all users that can access Netfinity Director. It shows native
user accounts (those created in Windows User Manager), such as
Administrator in Figure 96, and non-native user accounts (those that have
been created in Netfinity Director), such as Dogol1 in Figure 96. The window
will also show if the user is currently logged onto a console. The User menu
has the following functions:

• New User. Create your own users independent of Windows’ security
model.
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• Edit. Modify existing users created either in Windows User Manager or
created in Netfinity Director’s User Editor.

Note: If you attempt to modify a user that is a member of the
TWGSuperAdmins group, you will see that all settings in the User Editor
have been grayed out, except for the e-mail address and pager information
fields. You cannot modify the access of TWGSuperAdmins users — they
have complete control in Netfinity Director.

• Delete. Delete non-native users (those that have been created in Netfinity
Director) and native users that are members of TWGAdmins or
TWGSuperAdmins but are not members of Administrators or Domain
Admins.

• User Defaults. Set up or change defaults authorizations that all new users
created in Netfinity Director will have.

• Show Unauthorized Server Users. Shows all users defined via the
Windows User Manager, including those that are not authorized to access
Netfinity Director.

To create a new non-native user account in Netfinity Director, click User >
New User. The User Editor appears, similar to Figure 97. Here, we created a
user similar to the Netfinity Manager user shown in Figure 95 on page 131
and used the data from Table 8 on page 131 as input.

Note: The services in Netfinity Manager have a corresponding task in the
Task Entry tab of the User Editor as shown in Figure 100 on page 137.
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Figure 97. Basic information about the user

The security model in Netfinity Director is much stronger than in Netfinity
Manager and offers more granularity. You can set different privileges to
different users as shown in Figure 98 on page 135. These will affect all
systems that the user can access.

If you wish to set default access settings, click User > Set User Defaults.
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Figure 98. Privileges we can grant to a user

By default, the user has access to all groups. To change this, use the Group
Access tab and select the groups you want to give access to, as shown in
Figure 99.
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Figure 99. Group Access configuration

The Task Access tab, shown in Figure 100, lets you limit access to specific
functions in Netfinity Director. This is similar to the security access settings in
Netfinity Manager.
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Figure 100. Task Access configuration

Once you have configured the security access, click OK.

Based on the settings you have made here, Netfinity Director will display a
desktop that will show only the supported functions for the specific user.

7.3 System Monitor

The System Monitor in Netfinity Manager lets you monitor system
performance and to set thresholds to alert you when system components
have exceeded set values. The thresholds are set by right clicking on the
particular monitor and clicking Open > Thresholds. For the CPU Utilization
monitor, a window similar to Figure 101 appears.
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Figure 101. Threshold configuration in Netfinity Manager

Use Table 9 to record all the thresholds you monitor. The example in Figure
101 is shown as a sample.

Notes:

• You cannot specify the severity for each level in Netfinity Director, so there
is no need to record these values.

• The checkbox Notify specifies that the alert is to appear on the system’s
window as well as any other action. Since this function is not supported in
Netfinity Director, it can be ignored.
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Table 9. Thresholds in Netfinity Manager

To add this data to Netfinity Director, do the following (we’ll use our sample
CPU Utilization threshold as an example):

1. From the Group Contents panel of the console, right-click on the system
and select Resource Monitors from the menu. Figure 102 appears.

Figure 102. Resource Monitors in Netfinity Director

2. Expand CPU Monitors to show the available CPU monitors. Right-click on
CPU Utilization and click Add to Selected Resource Table (or double
click on CPU Utilization). This will add the monitor to the right panel.

3. Right-click as shown in Figure 103 and click Individual Threshold.

Monitor Name Duration Resend Error
above

Warning
above

Warning
below

Error
below

CPU
Utilization

CPU 5 mins Never 100 80 None None
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Figure 103. Individual Thresholds in Netfinity Director

4. Figure 104 appears:
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Figure 104. CPU High Monitor in Netfinity Director

5. Fill in your data from Table 9 on page 139 and click OK.

The thresholds have now been configured.

7.3.1 Exporting recorded data

In Netfinity Manager, you can export System Monitor data to a Lotus Notes or
ODBC database. In Netfinity Director, you can export the data and you can
view the recorded data, as follows:

1. Right click as shown in Figure 103 but click Record instead. This brings
up the recording configuration page as shown in Figure 105.
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Figure 105. New Resource Monitor page in Netfinity Director

2. Select File > New that will bring up the New Record menu.

Figure 106. New Record menu in Netfinity Director

3. Enter a name, select a duration, and choose how long the recording will
last. Click OK to continue. This will bring up the configuration page as
shown in Figure 107.
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Figure 107. Resource Monitor Recording in Netfinity Director

From here you can:

• Export the data to:

– .TXT file
– .HTM file
– .CSV file

• Create a graph of the data recorded

• Delete the configuration

• Stop the recording

For more information about Resource Monitors and how to configure them
see 6.2.9 “Resource Monitors” in Netfinity Director Integration and Tools,
SG24-5389.

7.4 Event Scheduler

The Event Scheduler in Netfinity Manager is used to schedule tasks. To
export them to Netfinity Director you need to write down the names of your
events as shown in Figure 108. Use Table 10 on page 145 as a reference.
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Figure 108. Scheduler Service in Netfinity Manager

When you have noted all the events, you need to write down the configuration
of the events. Select each event, click Edit and write down the information
shown in Figure 109 into Table 10.
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Figure 109. Event information in Netfinity Manager

Table 10. Detailed scheduled event data

In Netfinity Director, start the Event Scheduler by clicking Task > Scheduler.
Figure 110 appears.

Name Frequency Date/time Groups or
systems

Retry for
offline

New
systems

Software inventory Weekly Wednesday 05:14pm All Yes Yes
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Figure 110. Scheduler in Netfinity Director

To create a new event, or job as it is called in Netfinity Director, click File >
New Job. This will bring up the New Scheduled Job window as shown in
Figure 111.
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Figure 111. New Scheduled Job menu in Netfinity Director

From here you can schedule the jobs to fit your needs.

For details about the Event Scheduler, see 3.2.7 “Task scheduling” in Netfinity
Director Integration and Tools, SG24-5389.

7.5 Remote System Manager

In Netfinity Manager, you can use system keywords to group your systems as
shown in Figure 112.



148 Migrating from Netfinity Manager to Netfinity Director

Figure 112. Using keywords to build groups in Netfinity Manager

In the installation process of Netfinity Director there is no equivalent function.
There are two ways of inserting free text data to Netfinity Director.

• Edit the TWGUSER.INI file on the client system

• Asset ID

7.5.1 Edit TWGUSER.INI

TWGUSER.INI exists on every client. The file is located in the BIN directory
of your Netfinity Director installation.

The TWGUSER.INI file is a plain ASCII file that you can insert data into.

###############################################################################
# Tivoli Workgroup Native Inventory Client Configuration File - twguser.ini
# (C) Copyright IBM Corporation 1994, 1998.
###############################################################################

################################################################
# User -
#   This section provides a mapping of IT Director Inventory
#   Database Table Column names to the actual information per
#   client which is collected by the Inventory Collection
#   Process such that this client information 
#   can to be viewed in the Inventory Query Browser and used in
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#   the Group Editor Consoles. Each client should add/edit this
#   information so that it may be gathered during the next
#   scheduled Inventory Collection.
#
#   NLS Note - only the values should be translated
#     (the column names remain the same)
################################################################
[USER]
   FIRST_NAME      =
   MIDDLE_NAME     =
   LAST_NAME       =
   EMPLOYEE_ID     =
   TITLE           =
   DEPT_NAME       =
   DEPT_NUMBER     =
   DIVISION        =
   WORK_PHONE      =
   CELLULAR_PHONE  =
   FAX_NUMBER      =
   PAGER_NUMBER    =
   PAGER_TYPE      =
   EMAIL_ADDRESS   =
   HOME_PHONE      =
   
   
[LOCATION]
   CITY            =        
   STATE           =       
   ZIPCODE         =     
   COUNTRY         =     
   BUILDING        =    
   FLOOR           =       
   ROOM_NUMBER     = 
   LATITUDE        =    
   LONGITUDE       =   
   USER_DATA1      =   
   USER_DATA2      =   

You can add the system keywords to this file, and then create dynamic groups
based on the information.

Note: If you add data to TWGUSER.INI after the client has been discovered
and inventoried, the configuration will not appear until you perform an
inventory collection from the Netfinity Director console.

More information about inventory and inventory collections can be found in
Chapter 3, “Core functions” in Netfinity Director Integration and Tools,
SG24-5389.

7.5.2 Asset ID

Similar to the System Profile service in Netfinity Manager, the Asset ID task
offers information on your IBM hardware. You can also enter your own
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information about warranty, leasing, purchase date, and other information as
shown in Figure 113. For more information about Asset ID see:

http://www.pcco.ibm.com/ww/assetid/

Figure 113. Asset ID in Netfinity Director

You can create your own parameters and add values to them. After you have
saved the Asset ID information and performed an inventory collection you can
create groups based on the values you entered.

Note: You cannot create a dynamic group before you have the inventory data.
For more information about groups and inventory information see Chapter 3,
“Core functions” in Netfinity Director Integration and Tools, SG24-5389.

Depending on how your environment looks like you might want to use either
Asset ID or TWGUSER.INI or maybe both. Here are some key things about
the functions.

• TWGUSER.INI

– You can preconfigure the file and copy it when you install the client. If
you have some way to determine which system should have the

http://www.pcco.ibm.com/ww/assetid/
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different versions of TWGUSER.INI files, you don’t have to manually
add the values to every client.

– If you reinstall the client or wipe the hard drive, the configuration will be
lost.

• Asset ID

– Asset ID uses a separate EEPROM to store the configuration. That
means that you can wipe the hard drive and still keep the information.

– By default you will have to put in all the data manually for each of your
clients. For more information about Asset ID see:

http://www.pcco.ibm.com/ww/assetid/

7.6 Process Management

The process manager in Netfinity Manager is used to manage processes in
Windows, OS/2 and NetWare. From the process manager window shown in
Figure 114 you can:

• View running processes
• Run commands
• Stop processes
• Create alerts when a specific process starts or stops.

http://www.pcco.ibm.com/ww/assetid/
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Figure 114. Process Manager in Netfinity Manager

We are interested in copying the process alerts to Netfinity Director.

To access your configured process alerts in Netfinity Manager click Process
> Process Alerts... This brings up a window containing all your configured
process alerts as shown in Figure 115.

Figure 115. Process Alerts in Netfinity Manager
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To access the configuration data of the process alerts, highlight the alert and
click Edit. A window similar to Figure 116 appears.

Figure 116. Properties for process alert in Netfinity Manager

For each alert, enter the data in Figure 116 into Table 11.

Table 11. Process alerts

Note: The Notify checkbox, when enabled, displays a pop-up window on the
user’s workstation. This is not supported in Netfinity Director.

To access the process manager window in Netfinity Director, you can either
drag and drop the Process Management icon from the task panel to your
selected system or right-click the system and select Process Management.
Either will bring up Figure 117.

Program Name Alert when started Alert when stopped Not started within timeout

Example: Notepad None Severity 0 Severity 0, timeout=1 min
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Figure 117. Process manager in Netfinity Director

From here you can:

• See all started processes on the system
• Execute commands
• Send Ctrl-C to a process
• Send Ctrl-Break to a process
• Kill processes
• Monitor processes
• View and manage all Win32 services on the system
• View and manage all the device drivers on the system
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To create a process alert do the following:

1. Select the process you wish to work with.

2. Click Monitors > Process Monitors. Figure 118 appears.

Figure 118. Configuring an alert on a process

3. Fill in the values from Table 11 on page 153.

For our example, We checked Stop and Fail and entered 60 in the Timeout
field. Click File > Save and you will be prompted if you want to replace the
monitors. Click Yes to update your monitor. Close the window.

Now we need to set an action based on the alerts.

4. Start the Event Action Plan Builder to create an action by clicking in
the main console window.

5. Create a new event action plan by right clicking the Event Action Plans
panel and clicking New > Event Action Plan. Name the action plan
“Process Alerts”, as shown in Figure 119. You can use an existing Event
Action plan if you wish.
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Figure 119. Event Action Plan Builder in Netfinity Director

6. Create a filter for the process by right clicking the Event Filters panel and
clicking New > Simple Event Filter. This brings up the Simple Event Filter
Builder:
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Figure 120. Simple Event Filter Builder in Netfinity Director

7. In the Event Type tab, deselect the Any checkbox.

8. Expand Director, Director Agent and Process Alert branches as shown in
Figure 120.

9. Since we want to do the same when the process stops or fails, we
selected notepad.exe in both Process Failed to Start and in Process
Terminated as shown in Figure 120. We do that by holding down the Ctrl
key and clicking notepad.exe. Save the event filter by Select File > Save
as and name the filter. We named ours “Notepad process”.

10.Specify the action that will be performed based on the alert.

For our example, we want to start Notepad back up again. From the Event
Action Plan Builder, double-click Start a program on the “event” system
in the Actions panel (see Figure 119).

Figure 121 appears.
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Figure 121. Customize action in Netfinity Director

11.Enter the location of Notepad as shown. Click File > Save as and name
the action; we named it “Notepad”.

12.Now we have to activate the event action plan. Apply the new filter and
new action as follows:

a. Drag the newly created event filter “Notepad Process” from the Event
Filters panel to the Event Action Plans panel, shown as � in Figure
122.

b. Drag the newly created action “Notepad” from Actions panel to the
Event Action Plans panel, shown as� in Figure 122.

Note: You must perform these two steps in the correct order.
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Figure 122. Activating the event action plan

13.Close the Event Action Plan Builder window. The main console window
appears as shown in Figure 123.

14.Activate the event action plan by dragging it from the Tasks panel to the
system that you want to use the event action plan on, as shown in Figure
123.

�

�
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Figure 123. Activating the Event Action Plan

The action is now enabled in Netfinity Director.

Note: As we describe in 9.1.5, “Advanced group management” on page 173
there is no support to drop the event action plan to a group of systems in
Netfinity Director. In Netfinity Director, you can only activate the action on one
system at a time.

For more information on how to use and configure the Event Action Plan
Builder, see 6.2.3 “Event Action Plans” of the redbook Netfinity Director
Integration and Tools, SG24-5389.

7.7 Advanced System Management

The Advanced System Management functionality is the same in Netfinity
Manager and Netfinity Director. The GUI is the same and you can do the
same things.

All the configuration data in ASM PCI Adapter is stored in the adapter, which
means that you don’t have to convert any data or reconfigure your adapter.

If you have configured the adapter with Netfinity Manager you can see and
use that data in Netfinity Director without any further steps.

Drag the Event
Action Plan onto
the selected
system to
activate it.
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Chapter 8. Removing Netfinity Manager

Once you have UMS on all your clients and your Netfinity Director
configuration running properly, the next step you many want to consider is
removing Netfinity Manager. In most cases, removing Netfinity Manager is
optional because Netfinity Manager can run on the same system as UMS and
Netfinity Director.

There are a few reasons why you could leave Netfinity Manager on your
systems:

• No effort required.

• You may wish to use Netfinity Manager as an emergency backup if
Netfinity Director is unavailable.

However, there may be reasons why you should consider removing Netfinity
Manager:

• Reclaim disk space (15-30 MB) and memory (5-10 MB) consumption
taken by Netfinity Manager.

• On NetWare systems, Netfinity Manager and Netfinity Director cannot
coexist due to a module name contention. You must unload NETFBASE
from memory and remove the statements from AUTOEXEC.NCF.

• You consider Netfinity Manager to be a security risk because passwords
are not stored in the Windows security accounts manager (SAM) database
as they are in Netfinity Director.

8.1 Uninstalling Netfinity Manager 5.x

There are two methods to remove Netfinity Manager 5.x:

• Manual uninstall using Netfinity uninstall program
• Unattended uninstall

8.1.1 Manual uninstall

To remove Netfinity Manager Version 5.0 or later, click Start > Programs >
Netfinity > Netfinity Uninstall or run NFUNINST from the Netfinity Manager
installation directory (for example, C:\WNETFIN on Windows systems).

You will be prompted to confirm the removal as shown in Figure 124 and
Figure 125.
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Note: On Windows systems, you cannot use Add/Remove Programs to
uninstall Netfinity Manager.

Figure 124. Uninstall warning window

Figure 125. Uninstall completed

8.1.2 Unattended uninstall

On Windows 95/98 and Windows NT systems, you can remove Netfinity
Manager 5.0 or later by issuing the following command:

NFUNINST /R:

(Note the colon at the end). You are not prompted to confirm the removal.
Once the command is complete, you should reboot the system.

8.2 Uninstalling versions earlier than Netfinity Manager 5.x

For systems running Netfinity Manager 5.0 or later, no uninstall routine exists.
As a result, you have two options:

• Upgrade Netfinity Manager to the latest version, then use the uninstall
routine to remove the product

• Delete all files and configuration settings (for example, registry entries on
Windows systems)

If you want to upgrade to the latest version of Netfinity Manager, you can
download it from:

http://www.pc.ibm.com/ww/netfinity/systems_management/nfmgr.html
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To delete all files and registry entries, do the following:

1. Stop the Netfinity Service (NETFBASE)

2. In the registry, remove Netfinity information from the following keys:

– HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVers
ion\RunServices (remove value name and data: NetFinity,
c:\wnetfin\netfbase.exe)

– HKEY_LOCAL_MACHINE\SOFTWARE\IBM\NetFinity\CurrentVersion

– HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\

3. Remove all files and directories where Netfinity is installed (C:\WNETFIN
or C:\NETFIN)
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Chapter 9. Upgrading to IT Director

Netfinity Director is based on Tivoli’s IT Director. However, not all the
functionality of IT Director is available in Netfinity Director. This chapter
describes the extra features you get when you upgrade to IT Director. We also
show how to do the upgrade.

9.1 Extra features

When you upgrade your Netfinity Director system to IT Director, a number of
functions are added or upgraded. These include:

• Improved software distribution
• SNMP browser that supports all SNMP devices
• Application management
• Internet services
• Group management
• Associations

The following tables compare the two products.

Table 12. Comparing core features

Core features IT Director Netfinity Director

User administration Yes Yes

Software distribution Yes Limited

Job task scheduling Yes Yes

Event management Yes Yes

Real-time monitoring Yes Yes

Process Manager Yes Yes

Remote control Yes Yes

File transfer Yes Yes

Microsoft Cluster Server support Yes Enhanced

Inventory CIM/DMI support Yes Yes

Maximum number of clients 1500 1500

AS/400 support Yes Not supported

NetWare 5.0 support Yes Yes
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Table 13. Comparing application management

Table 14. Comparing Internet management features

Table 15. Comparing tools support

Figure 126 shows the Tasks menu in Netfinity Director. Compare it with the IT
Directors Task menu shown in Figure 127. You will see that there are many

Database support Yes Yes

SNMP management interface Yes Not supported

Apply Event Action Plans to group Yes Not supported

Set monitor threshold on groups Yes Not supported

Application management features IT Director Netfinity Director

Application management support Yes Not supported

Tivoli Manager for Domino Yes Not supported

Tivoli Manager for SQL Server Yes Not supported

Tivoli Manager for MS Exchange Yes Not supported

Tivoli Manager for Norton 2000 Yes Not supported

NAV Plus for Tivoli IT Director Yes Not supported

Info. Tech. and Software Asset Manager Yes Not supported

Internet management IT Director Netfinity Director

Web Channel Yes Not supported

System Management Home Page Yes Not supported

Internet Event Action Plans Yes Not supported

Tools support IT Director Netfinity Director

SDK support Yes Yes

MPM support Yes Netfinity Manager only

Core features IT Director Netfinity Director
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tasks that are added in the upgrade. We will describe the different tasks and
functions that have been added.

Figure 126. Netfinity Director Tasks Menu

Figure 127. IT Director Tasks menu

This section introduces these extra features. For more information about
these features, see the redbook Integration Examples for Tivoli IT Director: A
First Look, SG24-5207 or visit Tivoli’s home page:

http://www.tivoli.com

9.1.1 Software distribution

With Netfinity Director, you can distribute only predefined UMS and UM
Server Extensions packages. As shown in Figure 128, you cannot build your
own packages.
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Figure 128. Software distribution in Netfinity Director

With IT Director, you can create your own software distribution packages, use
pre-configured templates and directly import unattended installation files to IT
Director as shown in Figure 129.

Figure 129. Software Distribution Manager in IT Director

You can also use distribution servers and specify a bandwidth limit for these
software distributions.

A distribution server acts as a staging area on a remote site. If you have a
WAN connection between two sites you can assign a system on the other site
to act as a distribution server. With this function it will be necessary to send
the file package only once over the WAN connection. When the file package
has arrived at the distribution server, it will provide the assigned clients with
the software.
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9.1.2 SNMP functions

In Netfinity Director, the Configure SNMP Agent tool only is used to configure
the SNMP agent on the clients. Netfinity Director listens for SNMP traps from
specific products and translates them into Netfinity Director alerts. The
following products are supported today in Netfinity Director:

• IBM tape drives using the following tape backup software:

– CA ARCserveIT for NT and NetWare
– Veritas (formerly Seagate) Backup Exec for NT and NetWare

• APC Uninterruptible Power Supplies via the APC PowerChute software

• IBM Fibre Channel RAID adapter

• Alert on LAN events forwarded from the Alert on LAN proxy

The SNMP browser in IT Director lets you view detailed information on any
SNMP devices as shown in Figure 130.

Figure 130. SNMP Browser in IT Director
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With the SNMP browser you can manage network devices, printers, and PCs
that have SNMP agents installed or embedded. Tasks that can be performed
on SNMP devices include:

• Event action plans
• Inventory
• Resource monitors

With IT Director’s SNMP browser, you can also compile MIB files from
different vendors to gain improved manageability from their products.

9.1.3 Application management

In Netfinity Director there is no support for application management.

With IT Director, you can control and manage server applications directly
from the IT Director console, rather than working at the server. The types of
tasks that you can perform depend on the server application and the degree
to which the server application interfaces with Tivoli’s Application
Management Specification (AMS).

AMS was developed in open collaboration with partners and customers and is
an industry standard. A software package created using AMS is called an
application management package (AMP) and is a single compressed file,
formatted according to the AMS 2.0 specification.

The AMP file contains all of the information necessary to enable IT Director to
manage an application. Generally there is a specific AMP for each software
application. The value that an AMP brings to the IT Director environment is
threefold:

• Software distribution
• Operational tasks
• Monitoring

There are two AMPs included in IT Director: one for Netscape SuiteSpot and
one for Microsoft Internet Information Server (IIS) as shown in Figure 131.
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Figure 131. Application management in IT Director

The Netscape SuiteSpot AMP provides management functionality for the
following Netscape Internet products:

• Netscape Enterprise 3.0
• Netscape Enterprise 3.5.1
• Netscape Proxy 2.5
• Netscape Proxy 3.5

The Microsoft IIS AMP provides management functionality for the following
Microsoft Internet products:

• Microsoft IIS 3.0
• Microsoft IIS 4.0
• Microsoft Proxy Server 1.0
• Microsoft Proxy Server 2.0

Tivoli also has additional AMPs available, including:

• Tivoli Manager for Microsoft SQL Server—IT Director Edition
• Tivoli Manager for Domino—IT Director Edition
• Tivoli Manager for Microsoft Exchange—IT Director Edition

A lot of third-party companies develop AMPs for IT Director to allow
integration of their products with IT Director. You can also create your own
AMPs with the Tivoli Module Designer (TMD) for IT Director. This means that
it is possible for you to manage applications that do not have a management
interface, such as applications developed in-house. More information about
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application management can be found in the redbook Managing Applications
with Tivoli IT Director, SG24-5282.

9.1.4 Internet services

Netfinity Director lets you send alerts via the Internet by sending e-mail or by
publishing to a news group. With IT Director, you can use the Internet to
expand manageability. This lets you communicate information about the
network to your end users. The Internet services offered in IT Director
include:

• Managing Web servers, such as IIS or Netscape SuiteSpot
• Sending alerts via e-mail and publishing alerts to news groups
• Subscribe to information channels (for example, from resellers)
• Offering a Web page to users to perform management functions

– Publishing systems monitors to the Web
– Publishing events to the Web
– Web page-requested software distribution

The Systems management channel provides a link for your IT Director
reseller to provide you with support.

For example, resource monitoring, event management, and software
distribution can use the Internet to notify users when specific events occur
and to enable users to request software packages from the Web as shown in
Figure 132.



Chapter 9. Upgrading to IT Director 173

Figure 132. IT Director Homepage

9.1.5 Advanced group management

In Netfinity Director you cannot perform some tasks on groups of systems.
For example, you can assign event action plans to individual systems but not
to a group of systems.
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As shown in Figure 133, the Groups contents is grayed out. If you want to
assign an event action plan to a group of systems you have to assign them
individually.

Figure 133. Event Action Plans view in Netfinity Director

In IT Director two group functions are added:

• You can assign event action plans to a group of systems. By default Log
All Events is activated for the group All Systems and Devices as shown in
Figure 134.

• You can create thresholds for a group of systems in IT Director. For
example, if you create a threshold for the CPU, with IT Director you can
assign it to a group of systems. In Netfinity Director, you have to assign it
to every system that will use it.

Figure 134. Event Action Plans by IT Director
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9.1.6 Associations

With Netfinity Director, the group contents can only be shown alphabetically
or sorted by system type. A number of view options (“associations”) are
grayed out in Netfinity Director as shown in Figure 135.

Figure 135. Association of systems

In IT Director these grayed-out options are now available. One useful
association is to view the contents group by TCP/IP address. Do this by
right-clicking in the Group Contents panel and clicking Associations >
TCP/IP Addresses. The result in our lab is shown in Figure 136:
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Figure 136. Showing the Group Contents panel by TCP/IP address

9.1.7 AS/400 Support

In Netfinity Director there is no support for AS/400. In IT Director, you can use
an AS/400 as an IT Director server or as a client. For more information about
AS/400, see the Netfinity Director Installation and User’s Guide (which
includes the complete Tivoli IT Director User’s Guide as Chapter 4). The
combined user’s guide is available as NFDBOOK.PDF in the Documents
directory on the Netfinity Director installation CD.

For more information, see http://www.tivoli.com.

9.2 How to upgrade Netfinity Director to IT Director

The upgrade installation process is very easy and you do not have to install
new software or reinstall your management server. All the functions in IT
Director are installed by the Netfinity Director installation program. To activate
the full IT Director product you need to purchase a new license key.

Before you begin the upgrade process we recommend that you exit all
Netfinity Director consoles except the one that you will perform the upgrade
from. To start the license key upgrade click Options > License
Administration as shown in Figure 137:
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Figure 137. Option menu

Figure 138 shows all license keys installed.You can have many client license
packages installed at the same time, but only one server license key can be
active at one time.

Figure 138. License Administration overview

Click License > Add Licenses Key. Figure 139 appears:
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Figure 139. Add License Key

Type in the license key and the Message Browser will pop up as shown in
Figure 140.

Figure 140. Server successfully upgraded to IT Director

Restart the Netfinity Director server by issuing the following two commands
from a command prompt:

NET STOP TWGIPC
NET START TWGIPC

Now you should be able to access the complete IT Director product.
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Appendix A. Worksheets

This appendix contains larger versions of the worksheets described in
Chapter 7, “Recreating configuration data” on page 121.

A.1 Alert Manager

Table 16. Alert Manager worksheet

Action Alert types Severity Source
applications

Sender ID

Example: Notify user with pop-up Any 0,1,2,3 Any Any
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A.2 Security Manager

Table 17. Security Manager worksheet

User ID Services Security
Manager

Example: JOHAN Alert, AOL, CFM, DCM, Scheduler, POED, Process, Remote Session,
RWC, Inventory, SI, SysMon, Profile

No
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A.3 System Monitor

Table 18. Threshold alert worksheet

Monitor Name Duration Resend Error
above

Warning
above

Warning
below

Error
below

CPU
Utilization

CPU 5 mins Never 100 80 None None
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A.4 Scheduler

Table 19. Scheduler worksheet

Name Frequency Date/time Groups or
systems

Retry for
offline

New
systems

Software inventory Weekly Wednesday 05:14pm All Yes Yes
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A.5 Process Manager

Table 20. Process Manager worksheet

Program Name Alert when started Alert when stopped Not started within timeout

Example: Notepad None Severity 0 Severity 0, timeout=1 min
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Appendix B. Special notices

This publication is intended to help customers, business partners and IBMers
to migrate Netfinity Manager installations to Netfinity Director. The
information in this publication is not intended as the specification of any
programming interfaces that are provided by Netfinity Manager or Netfinity
Director. See the PUBLICATIONS section of the IBM Programming
Announcement for Netfinity Manager and Netfinity Director for more
information about what publications are considered to be product
documentation.

References in this publication to IBM products, programs or services do not
imply that IBM intends to make these available in all countries in which IBM
operates. Any reference to an IBM product, program, or service is not
intended to state or imply that only IBM's product, program, or service may be
used. Any functionally equivalent program that does not infringe any of IBM's
intellectual property rights may be used instead of the IBM product, program
or service.

Information in this book was developed in conjunction with use of the
equipment specified, and is limited in application to those specific hardware
and software products and levels.

IBM may have patents or pending patent applications covering subject matter
in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to the IBM
Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY
10504-1785.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact IBM
Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any
formal IBM test and is distributed AS IS. The use of this information or the
implementation of any of these techniques is a customer responsibility and
depends on the customer's ability to evaluate and integrate them into the
customer's operational environment. While each item may have been
reviewed by IBM for accuracy in a specific situation, there is no guarantee
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that the same or similar results will be obtained elsewhere. Customers
attempting to adapt these techniques to their own environments do so at their
own risk.

Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of
these Web sites.

The following terms are trademarks of the International Business Machines
Corporation in the United States and/or other countries:

The following terms are trademarks of other companies:

Tivoli, Manage. Anything. Anywhere.,The Power To Manage., Anything.
Anywhere.,TME, NetView, Cross-Site, Tivoli Ready, Tivoli Certified, Planet
Tivoli, and Tivoli Enterprise are trademarks or registered trademarks of Tivoli
Systems Inc., an IBM company, in the United States, other countries, or both.
In Denmark, Tivoli is a trademark licensed from Kjøbenhavns Sommer - Tivoli
A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other
countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United
States and/or other countries and is used by IBM Corporation under license.

Alert on LAN AS/400
Asset ID DB2
DB2 Universal Database Domino
IBM IntelliStation
Lotus Lotus Notes
Netfinity Netfinity Manager
Notes OS/2
PC 300 Predictive Failure Analysis
ServeRAID SMART Reaction
ThinkPad Tivoli
Tivoli Ready Wake on LAN
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ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and other countries
licensed exclusively through The Open Group.

SET, SET Secure Electronic Transaction, and the SET Logo are trademarks
owned by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service
marks of others.
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Appendix C. Related publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

C.1 IBM Redbooks

For information on ordering these publications see “How to get IBM
Redbooks” on page 193.

• Netfinity Director Integration and Tools, SG24-5389

• Tuning Netfinity Servers for Performance — Getting the most out of
Windows 2000 and Windows NT 4.0, SG24-5287

• Integration Examples for Tivoli IT Director: A First Look, SG24-5207

• Managing Applications with Tivoli IT Director, SG24-5282

• Netfinity Server Management, SG24-5208

C.2 IBM Redbooks collections

Redbooks are also available on the following CD-ROMs. Click the CD-ROMs
button at ibm.com/redbooks for information about all the CD-ROMs offered,
updates and formats.

CD-ROM Title Collection Kit
Number

IBM System/390 Redbooks Collection SK2T-2177
IBM Networking Redbooks Collection SK2T-6022
IBM Transaction Processing and Data Management Redbooks Collection SK2T-8038
IBM Lotus Redbooks Collection SK2T-8039
Tivoli Redbooks Collection SK2T-8044
IBM AS/400 Redbooks Collection SK2T-2849
IBM Netfinity Hardware and Software Redbooks Collection SK2T-8046
IBM RS/6000 Redbooks Collection SK2T-8043
IBM Application Development Redbooks Collection SK2T-8037
IBM Enterprise Storage and Systems Management Solutions SK3T-3694

http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/
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C.3 Other resources

These publications are also relevant as further information sources:

• Netfinity Director Installation and User’s Guide, available on the product
CD-ROM

• UM Server Extensions User’s Guide, available from
ftp://ftp.pc.ibm.com/pub/special/sysmgmt/UMSRVEXT.pdf

• Netfinity Manager to Netfinity Director...A Smooth Transition, shipped on
the Netfinity Director product CD

C.4 Referenced Web sites

These Web sites are also relevant as further information sources:

• Netfinity Systems Management Home Page, covering Netfinity Director
and Netfinity Manager. Includes product information, downloads and user
guides: http://www.pc.ibm.com/ww/netfinity/systems_management/

• For customers with Netfinity Manager, you can get Netfinity Director for a
small fee from: http://www.pc.ibm.com/ww/netfinity/ 
systems_management/nfdirfulfill.html

• UM Services Home Page, including downloads of UMS:
http://www.pc.ibm.com/ww/software/applications/ums/

• UM Server Extensions, including downloads and the user guide:
http://www.pc.ibm.com/ww/netfinity/systems_management/nfdir 
/serverext.html

• Universal Manageability:
http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/

• IBM Announcement Letters (US): http://www.ibmlink.ibm.com/usalets

• Netfinity Director 2.12 product announcement:
http://www.ibmlink.ibm.com/usalets&parms=H_200-084

• SMBIOS information, including a DOS utility to determine the SMBIOS
revision level of your system:
http://www.ibm.com/products/surepath/other/smbios.html

• Asset ID: http://www.pc.ibm.com/ww/assetid/index.html

• Desktop Management Task Force: http://www.dmtf.org

• Alert on LAN: http://www.pc.ibm.com/us/desktop/alertonlan/index.html

http://www.pc.ibm.com/ww/netfinity/systems_management/
http://www.pc.ibm.com/ww/netfinity/systems_management/nfdirfulfill.html
http://www.pc.ibm.com/ww/netfinity/systems_management/nfdirfulfill.html
http://www.pc.ibm.com/ww/software/applications/ums/
http://www.pc.ibm.com/ww/netfinity/systems_management/nfdir/serverext.html
http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/
http://www.ibmlink.ibm.com/usalets
http://www.ibmlink.ibm.com/usalets&parms=H_200-084
http://www.ibm.com/products/surepath/other/smbios.html
http://www.pc.ibm.com/ww/assetid/index.html
http:\\www.dmtf.org
http://www.pc.ibm.com/us/desktop/alertonlan/index.html
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• ServerProven compatibility matrix:
http://www.pc.ibm.com/us/compat/applications/matrix.shtml

• IBM PC Institute for Netfinity Director training:
http://www.ibm.com/pc/training/

• IBM TechConnect (certification and technical information):
http://www.pc.ibm.com/techconnect/

• Online support, both forum-based and e-mail-based:
http://www.ibm.com/pc/ww/solutions/enterprise/support

http://www.pc.ibm.com/us/desktop/alertonlan/index.html
http://www.pc.ibm.com/us/compat/applications/matrix.shtml
http://www.ibm.com/pc/training/
http://www.pc.ibm.com/techconnect/
http://www.ibm.com/pc/ww/solutions/enterprise/support
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How to get IBM Redbooks

This section explains how both customers and IBM employees can find out about IBM Redbooks,
redpieces, and CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

• Redbooks Web Site ibm.com/redbooks

Search for, view, download, or order hardcopy/CD-ROM Redbooks from the Redbooks Web site.
Also read redpieces and download additional materials (code samples or diskette/CD-ROM images)
from this Redbooks site.

Redpieces are Redbooks in progress; not all Redbooks become redpieces and sometimes just a few
chapters will be published this way. The intent is to get the information out much quicker than the
formal publishing process allows.

• E-mail Orders

Send orders by e-mail including information from the IBM Redbooks fax order form to:

• Telephone Orders

• Fax Orders

This information was current at the time of publication, but is continually subject to change. The latest
information may be found at the Redbooks Web site.

In United States or Canada
Outside North America

e-mail address
pubscan@us.ibm.com
Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada (toll free)
Outside North America

1-800-879-2755
1-800-IBM-4YOU
Country coordinator phone number is in the “How to Order”
section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-403-267-4455
Fax phone number is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

IBM employees may register for information on workshops, residencies, and Redbooks by accessing
the IBM Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button.
Look in the Materials repository for workshops, presentations, papers, and Web pages developed
and written by the ITSO technical professionals; click the Additional Materials button. Employees
may access MyNews at http://w3.ibm.com/ for redbook, residency, and workshop announcements.

IBM Intranet for Employees

mailto: pubscan@us.ibm.com 
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://w3.itso.ibm.com/
http://w3.ibm.com/
http://www.redbooks.ibm.com/
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://www.elink.ibmlink.ibm.com/pbl/pbl
http://www.redbooks.ibm.com/
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IBM Redbooks fax order form

Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries. Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name

Company

Address

City Postal code

Telephone number Telefax number VAT number

Invoice to customer number

Country

Credit card number

Credit card expiration date SignatureCard issued to
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Abbreviations and acronyms

AMP application management package

AMS application management
specification

AOL alert on LAN

APC American Power Conversion, Inc.

API application programming interface

ASCII American National Standard Code
for Information Interchange

ASM Advanced System Management

BIOS basic input/output system

CA Computer Associates

CD-ROM compact disk-read only memory

CFM critical file monitor

CIM common information model

CPU central processing unit

DBMS database management system

DCM dynamic configuration manager

DMI desktop management interface

EAP event action plan

EEPROM electrically erasable programmable
read only memory

EMEA Europe/Middle East/Africa

GUI graphical user interface

HTML hypertext markup language

HTTP Hypertext Transfer Protocol

IBM International Business Machines
Corporation

ID identification

IIS Internet Information Server

IP Internet Protocol

IT information technology

LAN local area network

MB megabyte

MIB management information base

MIF managed information format

MOF managed object format

MPM Multi-Platform Manager

MSCS Microsoft Cluster Server

NLS National Language Support

ODBC open database connectivity

OEM other equipment manufacturer

POED power-on error detect

POST power-on self test

RAID redundant array of independent
disks

RAM random access memory

REXX restructured extended executor
language

RF radio frequency

RSP response

RWC remote workstation control

SAM Security Account Manager

SCO Santa Cruz Operation, Inc.

SDK software developers kit

SFT System Fault Tolerant

SI systems information

SMBIOS systems management BIOS

SMS System Management Server

SNMP Simple Network Management
Protocol

SP Scalable POWERparallel

SQL structured query language

TCP/IP Transmission Control
Protocol/Internet Protocol

TMD Tivoli Module Designer

TMR Tivoli Management Region
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UM universal manageability

UMA universal manageability agent

UMS universal manageability services

URL universal resource locator

WAN wide area network

WFM wired for management

WMI Windows management interface

WOL Wake on LAN
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Index

A
actions

See also Event Action Plans
Forward to MPM service 79
send an event message to a console user 84

administrative privileges 45
Administrators group 11
Advanced System Management 6, 18, 160
agent-server security 11
Alert Manager

compared to Netfinity Director 25
transferring data 122

Alert on LAN 22
alerts

Asset ID 19
creating an event action plan 81
MPM 77, 79

AMP 170
AMS 170
application management, IT Director 170
architecture 9
AS/400 support 176
Asset ID 19, 149
associations 175
auto discovery 76

B
broker, MPM 57

C
CA Unicenter TNG 3
Capacity Manager 6, 20
CIM

data from SNMP devices 97
introduced 3
system health alert via UMS 96
task in Netfinity Director 20

Cluster Systems Management 7
cluster tools 26
coexistence 31
comparison 3, 8
components of Netfinity Director 3
configuration data 121–160
connectivity, network 34
Console Security 132

Critical File Monitor 29, 121
customer data 121–160

D
database selection 4, 50
databases supported 39
DB2 Universal Database 39
deployment 31
discovery 14
DMI

alerts from Asset ID 19
introduced 3
support in UMS 97
task in Netfinity Director 23

DMTF 20
Domain Admins group 11
downloads

SMBIOS utility 40
software distribution packages 115
UM Server Extensions 8

DriveCopy 110
Dynamic Connection Manager 18
dynamic groups 13

E
Event Action Plans

creating a process alert 155
creating using the EAP Builder 81
inputting data from Netfinity Manager 125
task in Netfinity Director 24

event filters
creating a new filter 126, 156
pre-defined filters 26

Event Log 26
event scheduler 28
Event Scheduler, transferring data 143

F
Fibre Channel Storage Manager 7
file transfer 26
Forward to MPM service action 79
functions of Netfinity Director 14

G
Ghost images, UMS 110
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groups
IT Director, use with 173
Netfinity Director 13

groups, restricting access to 136

I
IBM Netfinity Systems group 69
installation

IT Director upgrade 176
Netfinity Director console 45
Netfinity Director server 45
UM Server Extensions 117
UMS 93

InstallShield 105
Intel LANDesk 3
IntelliStation workstations 37
interface, Netfinity Director 2
Internet services, IT Director 172
inventory 27

MPM 77, 89
IT Director 165–178

application management 170
AS/400 support 176
associations 175
group management 173
Internet services 172
licensing 44
Microsoft IIS, support for 170
Netfinity Director, compared with 165
Netscape SuiteSpot, support for 170
SNMP 169
software distribution 167
Tasks menu 166
upgrade process 176

J
Java-based user interface 3

K
keywords 13, 147

L
LANDesk

Netfinity Director integration 3
UMS installation option 97

licensing
IT Director 44

licensing, continued
MPM 43
Netfinity Director 42
non-IBM licensing 44

login scripts 110

M
Microsoft Cluster Browser 27
Microsoft IIS 170
Microsoft JET 39
Microsoft SMS 3
Microsoft SQL Server 39
migration planning 31
migrations, reasons for 1
MOF 20
mouse/keyboard takeover 28
MPM 57–92

alerts 79
auto discovery 68, 76
choosing the provider 59
compared with UMS clients 79
components 57
configuring 66, 73
discovering systems 65, 74
IBM Netfinity Systems group 69
installation 62, 71
installing UMS 112
inventory 89
inventory configuration 63, 73
licensing 43
managing clients 77
MPM Systems group 69
Netfinity Provider configuration 63, 73
recommended method 61
scenarios 57
software distribution 77, 92
tasks 77
UMS installation 112
what can you do? 58

MSCS 26, 27

N
native user accounts 11, 132
Netfinity Director

See also UMS
agent 5
architecture 9
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Netfinity Director, continued
clients

hardware prerequisites 39
installation 93
operating systems supported 38
prerequisites 41

client-server communications 9
components 3
console 5

hardware prerequisites 39
installation 46, 53
operating systems supported 38

Console Security 11
copying data from Netfinity Manager 121
databases supported 39
Event Action Plans 24
event scheduler 28
functions 14
groups 13
installation

console 46, 53
server 46, 53

interface 2
inventory

task in Netfinity Director 27
IT Director comparison 165
licensing 42
main window 8
MPM 57
Netfinity Manager

getting data from 121
Netfinity Manager, compared with 3
scheduler 28
security 10
server 4

databases supported 39
installation 46, 53
Network Driver Configuration 14, 50
operating systems supported 38
user ID used to install 45

transferring data from Netfinity Manager 121
Netfinity Manager

configuration data transfer 121
copying data to Netfinity Director 121
groups 13
Netfinity Director, compared with 3
peer-to-peer communications 9
removing 161
Security Manager 10

Netfinity Manager, continued
transferring data to Netfinity Director 121
uninstalling 161
Windows 2000 support 1

Netfinity Provider
See also MPM 57
Netfinity Provider configuration 63, 73
OS/2 client installation 101

Netfinity servers
supported systems 37

Netscape SuiteSpot 170
NetView 3
NetWare, UMS installation 104
network connectivity 34
Network Driver Configuration 14, 50, 100
network protocols 5
NFPRVCFG 63, 73, 90
NFUNINST 161
non-native user accounts 11, 132
notify checkbox 138

O
operating systems supported

console 5
server 4
summary 38
tasks 17
UMS 5

OS/2
UMS installation 100
unattended installation 109

P
PC Institute 37
PCs supported 37
PDF files 16
planning to migrate 31–44

changes required 34
client rollout 35
consoles, placement of 35
network capacity 35
prerequisites 35
sequence of the rollout 34
tasks used 36
test strategy 36
timeframe 33
topology 35
training 36
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planning to migrate, continued
turning off Netfinity Manager 34

prerequisites
hardware 38
operating systems 38

privileges, user 135
process management

task in Netfinity Director 27
transferring data from Netfinity Manager 151

Process Manager, Netfinity Manager 81
product publications 16
protocols 5
provider, MPM 57
publishing to the Web 172

R
RAID manager 7, 29
reasons to migrate 1
Remote Control Agent, UMS 102
Remote Session 29
Remote Workstation Control 28
removing Netfinity Manager 161
Resource Monitor 28, 139
RF ID 19

S
scheduler 28
scheduler, transferring data 143
Screen View 30
security

introduced 1
Netfinity Director 10

Security Manager, transferring data 130
ServeRAID Manager 29
service, TWGIPC 12
severity levels 127
SMBIOS

Asset ID 19
Netfinity Director support 2
prerequisites 39
tool to verify support 40

SMS
support in Netfinity Director 3

SMS, sending messages to 96
SNMP

Configure SNMP Agent task 22
introduced 3
IT Director 169

SNMP, continued
Netfinity Director 169
sending alerts to 96
UMS support 97

software distribution 29
IT Director 167
MPM 77, 92
packages for downloading 115

Software rejuvenation 7
sort groups by (associations) 175
SP Switch administration 7
static groups 13
status of the server 51
supported systems 37
system health monitoring, UMS 96
System Monitor

exporting data 141
transferring data 137

T
taskbar icons 51
task-based groups 13
tasks

Advanced System Management 18
Asset ID 19
Capacity Manager 20
CIM browser 20
Configure Alert on LAN 21
Configure SNMP Agent 22
DMI Browser 23
Event Action Plans 24
Event Log 26
File Transfer 26
giving access to via Console Security 137
IBM Cluster Tools 26
Inventory 27
Microsoft Cluster Browser 27
Process Management 27
Remote Control 28
Resource Monitor 28
ServeRAID Manager 29
Software Distribution 29
starting 17

TCP/IP addresses, associations 175
ThinkPad notebooks 37
thresholds 137
ticker tape 8
Tivoli Enterprise Framework 3



201

Tivoli management agent, UMS 97
training 36
transferring data

Alert Manager 122
Event Scheduler 143
Process Management 151
Security Manager 130
System Monitor 137

TWGAdmins group 11
TWGIPC service 12
TWGIPCCF 14, 100
TWGMACH.ID file 110
TWGMachineID key 110
TWGSRVST 51
TWGSuperAdmins 11
TWGUSER.INI file 148

U
UM Server Extensions

described 6
download 8
installation 117
software distribution 92
unattended installation 118

UMA support 6
UMS

Basic Services 95
configuration options 95
Ghost images 110
hardware requirements 39
icons 99
installation 93
introduced 5
MPM installations 112
NetWare clients 104
Network Driver Configuration 14, 100
options 95
OS/2 clients 100
prerequisites 39, 41
SMBIOS 6, 40
software distribution 92
unattended installation 105
user authorization for remote access 99
Windows clients 93

unattended
installation of UMS 105
removal of Netfinity Manager 162

uninstalling Netfinity Manager 161

user authorization for remote access 102
user guides 16
user IDs, creating 133
user IDs, used to install server 45
user-logon security 10

W
Wake on LAN

enabling on OS/2 103
enabling on Windows 50
Netfinity Director support 13

Web Based Access, UMS 96
Web Manager 29
Web, publishing to 172
Windows

Administrators group 11
Domain Admins group 11
UMS installation 93
unattended UMS installation 105

Windows 2000
MPM Provider 57
Netfinity Manager 1

Wired For Management specification 40
WMI 21
worksheets 121, 179

Alert Manager 124
Event Scheduler 145
Security Manager 131
System Monitor 139
thresholds 139
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IBM Redbooks review

Your feedback is valued by the Redbook authors. In particular we are interested in situations where a
Redbook "made the difference" in a task or problem you encountered. Using one of the following
methods, please review the Redbook, addressing value, subject matter, structure, depth and
quality as appropriate.

• Use the online Contact us review redbook form found at ibm.com/redbooks
• Fax this form to: USA International Access Code + 1 914 432 8264
• Send your comments in an Internet note to redbook@us.ibm.com

Document Number
Redbook Title

SG24-6155-00
Migrating from Netfinity Manager to Netfinity Director

Review

What other subjects would you
like to see IBM Redbooks
address?

Please rate your overall
satisfaction:

O Very Good O Good O Average O Poor

Please identify yourself as
belonging to one of the
following groups:

O Customer O Business Partner O Solution Developer
O IBM, Lotus or Tivoli Employee
O None of the above

Your email address:
The data you provide here may
be used to provide you with
information from IBM or our
business partners about our
products, services or activities.

O Please do not use the information collected here for future
marketing or promotional contacts or other communications beyond
the scope of this transaction.

Questions about IBM’s privacy
policy?

The following link explains how we protect your personal information.
ibm.com/privacy/yourprivacy/

http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/contacts.html
http://www.redbooks.ibm.com/contacts.html
http://www.ibm.com/privacy/yourprivacy/
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